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Precautions for Safety 
 
Always read the specifications issued by the machine maker, this manual, related 
manuals and attached documents before installation, operation, programming, 
maintenance or inspection to ensure correct use.  
Understand this numerical controller, safety items and cautions before using the unit. 
This manual ranks the safety precautions into "Danger", "Warning" and "Caution". 
 

When the user may be subject to imminent fatalities or major 
injuries if handling is mistaken. 
 
When the user may be subject to fatalities or major injuries if 
handling is mistaken. 
 
When the user may be subject to bodily injury or when physical 
damage may occur if handling is mistaken. 

 

Note that even items ranked as "  CAUTION", may lead to major results depending on 
the situation. In any case, important information that must always be observed is 
described. 
 

 DANGER 

 Not applicable in this manual. 

 

 WARNING 

 Not applicable in this manual. 

 

 CAUTION 

1. Items related to product and manual 
 For items described as "Restrictions" or "Usable State" in this manual, the instruction 

manual issued by the machine maker takes precedence over this manual. 
 An effort has been made to describe special handling of this machine, but items that 

are not described must be interpreted as "not possible". 
 This manual is written on the assumption that all option functions are added. Refer to 

the specifications issued by the machine maker before starting use. 
 Refer to the Instruction Manual issued by each machine maker for details on each 

machine tool. 
 Some screens and functions may differ depending on the NC system or its version, 

and some functions may not be possible. Please confirm the specifications before 
use. 

 

2. Precautions for startup and maintenance 

 Before starting program modification, forced output, RUN, STOP or similar operation 
during running, read the manual carefully and ensure safety fully. Not doing so can 
cause machine damage or accidents due to operation mistakes. 

(Continued on next page)

DANGER 

WARNING 

CAUTION 



 

 CAUTION 

3. Items related to program development 
 If the data transferred does not follow the file name rule, the NC will mistake it for 

another data, resulting in unexpected operation, e.g. PLC program erasure. 
 Do not read a ladder file on which a conversion error occurred into the GX Developer 

side. The file may include unexpected contents to result an illegal operation. 
 If the ladder program being run by the CNC differs from the one being displayed on 

GX Developer, monitoring will not result in an error but will continue. 
 When an error occurred at GX Developer On-line function, the error message may not 
explain exactly the state in the CNC side. 
Always refer to the error list. 
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1.  INTRODUCTION 
 

In the EZMotion-NC E60/E68, the user PLC development environment is supported using MELSEC 
PLC development tool, which is Mitsubishi integrated FA software MELSOFT series (GX Developer) 
in addition to the onboard ladder tool. 
This manual explains user PLC development environment using GX Developer, mainly usage 
specific to EZMotion-NC E60/E68. 

 
Details described in this manual 
 

 CAUTION 
 Items not described in this manual must be interpreted as "not possible". 
 Some screens and functions may differ depending on the NC system or its version, and some 
functions may not be possible. Please confirm the specifications before use. 

 
General precautions 
 

Refer to the respective manuals for details of the EZMotion-NC E60/E68 PLCs and for details of 
various tools described in this manual. 
 
[EZMotion-NC E60/E68 PLC related documents] 
 

EZMotion-NC E60/E68 Series   PLC Onboard Instruction Manual …… IB-1500179(ENG) 
EZMotion-NC E60/E68 Series   PLC Programming Manual  
 (Ladder section with MELSEC tool) .……………………………………… IB-1500178(ENG) 

 
[MELDAS Series Software Package Manual] 
 

GX Developer Version8   Operating Manual (Startup) 
……. SW8D5C-GPPW 13JU40 SH-080372 

 
GX Developer Version8   Operating Manual 

……. SW8D5C-GPPW  13JU41 SH-080373 
 
GX Converter Version1   Operating Manual 

……. SW0D5C-CNVW 13J949 IB-0800004 
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2.  SYSTEM CONFIGURATION 
 

2.1  Development Environment Configuration 
 
Most of the development work can be done by connecting a personal computer and a CNC unit by 
an RS-232C cable. 
 
 
 

 

Data save

Floppy disk drive unit DOS format FLDPLC program editing
Ladder monitor

EZMotion-NC E60

New development is enabled by offline
development only.

Personal computer

PLC program creation
Message creation
Ladder monitor

Ladder printout
Message printout

RS-232C

Offline development, online development

Printout
General-purpose printer

CNC control unit

Onboard development

/E68
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2.2  Software Configuration 
 

PLC development tool
for MELSEC

GX Developer
(1)

IBM PC/AT *1

Compatible unit

QnA simulator

CNC controller

RS-232C
Comment converter

CLST6M

Ladder list converter
CLST6L

List output converter
PCNV6L

(4)

(5)

(3)
PLC onboard

Data conversion
package for MELSEC

GX Converter
(2)

*1:IBM PC/AT compatible personal
    computer with Windows OS  

 
(1)  GX Developer (PLC development software package) 

 
GX Developer is a programming software package (model name: SW7D5C-GPPW) designed 
for Mitsubishi Electric's MELSEC series programmable logic controllers. By performing 
operations similar to those of the MELSEC series, you can develop user PLC ladders for 
EZMotion-NC E60/E68. Note that some functions specific to the "MELSEC series" may not be 
unavailable. 
For EZMotion-NC E60/E68 ladder development, we recommend you to use GX Developer 
Version 4 (SW4D5C-GPPW) or later. For function details, refer to the operating manual 
supplied. 

 
(2)  GX Converter (data conversion software package) 

 
The GX Converter is a tool that carries out file conversion of GX Developer data files and the 
following: 

• Ladder list files and comment text files output by the CLIST6L 
• Alarms and operator messages created by the text editor 
• Data files of commercially available spreadsheet software, word processors and editors 

GX Converter is an add-on tool of GX Developer and is started from the GX Developer menu. 
This tool is a software package for various MELSEC support. GX Converter needs to be used 
with the versions following GX Developer Version 3 (SW3D5C-GPPW). Refer to the enclosed 
Operating Manual for function details. 

 
(3)  CLST6L (Ladder list converter) 

 
This tool converts the user PLC ladder list data developed with PLC4B to EZMotion-NC 
E60/E68 specification commands and devices, and outputs the data in a ladder list format. The 
user PLC ladder developed with PLC4B can be used for EZMotion-NC E60/E68 with the GX 
Developer by using the GX Converter to further convert the conversion results of this tool. Refer 
to the instruction manual for function details. 
 

(4)  CLST6M (Device comment converter) 
 
This tool outputs the contact/coil comment data of a user PLC ladder developed with PLC4B in 
the text format of the EZMotion-NC E60/E68 device specifications. The contact/coil comment 
data developed with PLC4B can be used with GX Developer by using GX Converter to further 
convert the conversion results of this tool. Refer to the instruction manual for function details. 
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(5)  PCNV6L (List output converter) 

 
This tool outputs a with PLC4B specification ladder printout image with cross information in a 
text format from the GX Developer specification ladder list and comment data. Refer to the 
instruction manual for function details. 
 
[Note]  PLC4B is MELDAS PLC programming tool. 

 
2.3  Operating Environment 

 
The tools that make up the development environment can be used with the personal computer that 
satisfies the following operating environment of GX Developer. 
The following are the specifications of the "GX Developer Version 7" operating environment. For the 
specifications of different versions, check them in the respective operating manuals (startup). 
 

Item Description 
Computer unit 133MHz or more∗1 Pentium (recommended) personal computer on 

which Windows operates. 
Required memory 32MB or more∗2 recommended 

For installation 150MB or more Hard 
disk 
area For operation 150MB or more 

Disk drive CD-ROM disk drive 
3.5 inch floppy disk drive∗3 

Display 800 × 600 pixel or more resolution 
Communication 
interface 

RS-232C port 

Basic software Microsoft Windows 95 operating system 
Microsoft Windows 98 operating system 
Microsoft Windows Millennium Edition operating system ∗4 
Microsoft WindowsNT Workstation 4.0 operating system 
Microsoft Windows 2000 Professional operating system ∗4 

 
∗1 : 150MHz or more Pentium is recommended for use of Windows Me. 
∗2 : 64MB or more is recommended for use of Windows 2000. 
∗3 : Required for GX Developer Version 6 or earlier (to provide protection by FLD). 
∗4 : The PC-9800 is unusable. 
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2.4  User PLC (Ladder) Development Procedure 
 
The following indicates a procedure for creating a general user PLC ladder. 
 

Determination of
machine
Determination of
CNC and PLC
specif ications
Determination of the
numbers of I/O points

Assignment of I/O
signals
Assignment of
internal relays

Programming

Start

Device Name Comment
X0 X-OT X-axis OT
X1 Y-OT Y-axis OT
X2 Z-OT Z-axis OT

Commercially available
spreadsheet tool

GX Developer

Onboard

The data created with the
commercially available
spreadsheet tool can be
used as ladder comment
data.

Procedure Personal Computer CNC Unit

Use GX Developer for
programming.
After completion, download
the data through RS-232C.

Perform monitoring/correction
with GX Developer's online
function or onboard function.

GX Developer

Complet ion

Test operation by
CNC unit

NO

YES

NO

YES

GX Developer

[BACKUP]
#1   BACKUP
#2   RESTORE

PARAM 3.2/2

Memory cassette
      (F-ROM)

Is test  operation
        OK?

Debugging operation

Program correction

Printout

Data save 

Is debugging
complete?

Program data Binary data

Program data:
Saved using GX Developer

Binary data:
Saved using DATA IN/OUT
screen

Printout to a commercial
printer connected with the
personal computer from GX
Developer.

BACKUP screen
DATA IN/OUT screen

Excute the ROM backup
operation on the BACKUP
screen.
Excute the binary data output
on the DATA IN/OUT screen.

#########
#########

#(  ) (                            )
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3.  GX Developer FUNCTIONS SUPPORTED BY EZMotion-NC E60/E68 
 
The GX Developer functions explained here are those supported by the EZMotion-NC E60/E68 in 
the "off-line functions" operated with the GX Developer independently and "on-line functions" carried 
out connected to the CNC. 
Refer to the enclosed Operating Manual for function details. 

 
3.1  Function Support Conditions (general section) 
 

The following shows a list of GX Developer outline functions supported by the EZMotion-NC 
E60/E68. A      mark indicates functions that can be used by the EZMotion-NC E60/E68. An r mark 
indicates that the function cannot be used because it is related to "MELSEC Series" characteristic 
functions. The function details during on-line are described in the next section. 
 

List of general section functions (1)  : Possible,  : Limitedly possible,  : Not possible 

Program type Support Remarks 
Ladder   
List   
SFC   
MELSAP-L   
Function block   

 
Function Menu Sub menu Support Remarks

Project New project    
 Open project    
 Close project    
 Save    
 Save as    
 Delete project    
 Verify    
 Copy    
 Edit Data New   
  Copy   
  Delete   
  Rename   
  Change program type   
 Change PLC type   Fixed Q4A 
 Import file Import from GPPQ format file   
  Import from GPPA format file   
  Import from FXGP[WIN] format file   
  Import from FXGP[DOS] format file   
  Import from TEXT ,CSV format file   
 Export file Export to GPPQ format files   
  Export to GPPA format files   
  Export to FXGP[WIN] format file   
  Export to FXGP[DOS] format file   
  Export to TEXT ,CSV format file   
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List of general section functions (2)  : Possible,  : Limitedly possible,  : Not possible 

Function Menu Sub menu Support Remarks 

(Project) Macro Registration macros   
  Macro utilize   
  Delete macros   
  Macro reference path   
 Function Block Diversion   
  Rename FB   
 Printer setup    
 Print    
 Start new GX Developer session    
 Exit GX Developer    
Edit Undo    
 Restore after ladder conversion    
 Cut    
 Copy    
 Paste    
 Insert line    
 Delete line    
 Insert row    
 Delete row    
 Insert NOP batch    
 Delete NOP batch    
 Draw line    
 Delete line    
 Change TC setting    
 Read mode    
 Write mode    
 Ladder symbol Open contact   
  Close contact   
  Open branch   
  Close branch   
  Coil   
  Application instruction   
  Vertical line   
  Horizontal line   
  Delete vertical line   
  Delete horizontal line   
  Rising pulse  Instead of DEFR

  Falling pulse   
  Rising pulse open branch   
  Falling pulse close branch   
  Invert operation results   
  Convert operation results to 

rising pulse 
  

  Convert operation results to 
falling pulse 

  

 Documentation Comment   
  Statement   
  Note   
  Statement/Note block edit   
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List of general section functions (3)  : Possible,  : Limitedly possible,  : Not possible 

Function Menu Sub menu Support Remarks 

Find/Replace Find device    
 Find instruction    
 Find step no.    
 Find character string    
 Find contact or coil    
 Replace device    
 Replace instruction    
 Change open/close contact    
 Replace character string    
 Change module start address    
 Replace statement/note type    
 Cross reference list    
 List of used devices    
Convert Convert    
 Convert (All programs being 

edited) 
   

 Convert (Online change)    
View Comment   

 Statement   
 Note   
 Alias   
 Macro instruction format display   
 Comment format 4*8 characters  
 3*5 characters  
 Alias format display Replace device name and 

display 
 

  Arrange with device and display  
 Toolbar   
 Status bar   
 Zoom 50%  
  75%  
  100%  
  150%  
  Auto  
 Project data list   
 Instruction list   
 Set the contact 9 contacts  
  11 contacts  
 Elapsed time   

Online  
  

 

Refer to "List of on-line section 
functions" 

Refer to "List of on-line section 
functions" 

 
Diagnostics PLC diagnostics   

 Network diagnostics   
 Ethernet diagnostics   
 CC-Link diagnostics   
 System monitor   



3. GX Developer FUNCTIONS SUPPORTED BY EZMotion-NC E60/E68 
3.1 Function Support Conditions (general section) 

 

 - 9 -

List of general section functions (4)  : Possible,  : Limitedly possible,  : Not possible 

Function Menu Sub menu Support Remarks 
Tools Check program   

 Merge data   
 Check parameter   
 Transfer ROM Read  
 Write  
 Verify  
 Write to file  
 Delete unused comments   
 Clear all parameters   
 IC memory card Read IC memory card  
 Write IC memory card  
 Read image data   
 Write image data   
 Start ladder logic test    
 Set TEL data Connection  
 Disconnection  
 TEL data  
 AT command  
 Call book  
 Intelligent function utility Utility list  
 Customize keys   
 Change display color   
 Options   Limited partly
 Create start-up setting file   

Window Cascade   
 Tile vertically   
 Tile horizontally   
 Arrange icons   
 Close all windows   

Help PLC error   
 Special relay/register A/QnA/FX series  
  Q series  
 Key operation list   
 Product information   
 Connect to MELFANS web   
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3.2  Function Support Conditions (on-line section)  
 

The following shows a list of GX Developer on-line functions supported by the EZMotion-NC 
E60/E68.  
A  mark indicates functions that can currently be used by the EZMotion-NC E60/E68. An r mark 
indicates that the function cannot be used because it is related to "MELSEC Series" characteristic 
functions. 

 
List of on-line section functions (1)  : Possible,  : Limitedly possible,  : Not possible 

Menu Sub menu Detailed function Support Remarks 

Transfer setup  PC side I/F   
  PLC side I/F  Only for QnACPU 
  Other station   
  Network route   
  Co-existence network 

route 
  

Read from PLC  Target memory   
  Title   
  File selection   
  Device data   
  Program   
  Common   
  Local   
  Refresh view   
  Free space volume   
  Create title   
Write to PLC  Target memory   
  Title   
  File selection   
  Device data   
  Program   
  Common   
  Local   
  Free space volume   
  Create title   
Verify with PLC  Target memory   
  Title   
  File selection   
  Program   
  Refresh view   
  Free space volume   
  Create title   
Write to PLC 
[Flash ROM] 

Write the program 
memory to ROM 

   

 Write to PLC 
[Flash ROM] 

   

Delete PLC data  Target memory   
  Title   
  File selection   
  Refresh view   
  Free space volume   
  Create title   
Change PLC data Attributes    
PLC user data Read PLC user data    
 Write PLC user data    
 Delete PLC user data    
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List of on-line section functions (2)  : Possible,  : Limitedly possible,  : Not possible 

Menu Sub menu Detailed function Support Remarks 

Monitor Monitor mode ON/OFF state   
  Scan time display   
  CPU state display   
 Monitor [Write mode]    
 Start monitor 

[All windows] 
   

 Stop monitor 
[All windows] 

   

 Start monitor    
 Stop monitor    
 Change current value 

monitor [Decimal] 
   

 Change current value 
monitor [Hexadecimal] 

   

 Local device monitor    
 Device batch Device   
  Connect   
  Coil   
  Setting value   
  Current   
  Monitor format : Bit & word   
  Monitor format : Bit   
  Monitor format : word   
  Display : 16bit integer   
  Display : 32bit integer   
  Display : Real number   
  Display : ASCII character   
  Value : DEC   
  Value : HEX   
  T/C set value Reference 

program 
  

  Device test   
 Entry data monitor Device   
  ON/OFF/Current   
  Setting value   
  Connect   
  Coil   
  Display : 16bit integer   
  Display : 32bit integer   
  Display : Real number   
  Display : ASCII character   
  Value : DEC   
  Value : HEX   
  T/C setting value, Local 

label Reference program 
  

  Device test   
 Buffer memory batch    
 Monitor condition setup Device   
  Step No.   
 Monitor stop condition setup Device   
  Step No.   
 Program monitor list    
 Interrupt program monitor list    
 Scan time measurement    
 Entry ladder monitor    
 Delete all entry ladder    



3. GX Developer FUNCTIONS SUPPORTED BY EZMotion-NC E60/E68 
3.2 Function Support Conditions (on-line section) 

 

 - 12 -

List of on-line section functions (3)  : Possible,  : Limitedly possible,  : Not possible 

Menu Sub menu Detailed function Support Remarks 

Debug Device test FORCE ON   
  FORCE OFF   
  Toggle force   
  Device   
  Buffer memory   
 Forced input output 

registration/cancellation
   

 Debug    
 Skip execution    
 Partial execution    
 Step execution    
Trace Sampling trace    
Remote operation  PLC status   
  RUN   
  STOP   
  PAUSE   
  Latch clear   
  STEP-RUN   
  Reset   
  Operation during RUN, 

STEP-RUN 
  

  Specify execution 
destination 

  

Keyword setup Register    
 Delete    
 Disable    
Clear PLC memory     

 Target memory  Format PLC 
memory  Format Type  

For only internal F-ROM 

Arrange PLC 
memory 

    

Set time  YY MM DD Hr. Min. Sec.   
  Day   
  Specify execution target   
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4.  SETUP 
 
4.1  Installing the Tools 
 

In the EZMotion-NC E60/E68 PLC development environment, it is assumed that the various tools 
are used with an IBM PC/AT compatible personal computer. Prepare each tool so that it is IBM 
PC/AT compatible personal computer. 
Refer to the enclosed Operating Manual (Startup section) and Operating Manual for the setup and 
start procedures of each tool. 
 

4.2  Connecting the Serial Cable 
 
For the position of the serial port, etc., refer to the Connection Manual. 
 
Between the IBM PC/AT compatible personal computer that uses GX Developer and the CNC, use 
an RS-232C serial cable equivalent to the one shown below in the RS-232C connection diagram. 
 
[Note] 
The cables given in the connection diagrams of the GX Developer Operating Manual cannot be 
used. 

 

NC side 
(25-pin D-SUB) 

 Personal 
computer side 
(9-pin D-SUB) 

Signal name Pin 
No.

Cable 
connection and 
signal direction

Pin 
No. Signal name 

CD 8  1 DC 
SD 2  2 RD 
RD 3  3 SD 
DR (DSR) 6  4 ER (DTR) 
SG 7  5 SG 
ER (DTR) 20  6 DR (DSR) 
CS (CTS) 5  7 RS (RTS) 
RS (RTS) 4  8 CS (CTS) 

 

 22  9 RI 

 

 

∗ The above shows a general RS-CS method connection format. 
∗ The pin Nos. of dotted lines are not used. 
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5.  COMMON ITEMS 
 

5.1  Precautions before Development 
 

Pay careful attention to the following items before developing ladder programs using the GX 
Developer. 

 
(1)  PLC Type Selection 

 
The PLC type must be set when newly creating programs, etc. Select the following CPU type when 
requested to select the PLC type by the GX Developer. An error will occur during transfer of the 
ladder program to the CNC if another PLC type is selected. 
 

 CAUTION    Select "Q4A" for CPU type. 
 

(2)  Device Setting 
 
Do not set the devices when developing the ladder program for the CNC. Develop the program with 
the device settings (No. of points, etc.) left at their default values applied when GX Developer was 
started. The ladder program cannot be transferred to the CNC normally when it is developed with 
settings other than the default values. 
 

 CAUTION    Do not set the devices.  
 

(3)  PLC Commands 
 
MELSEC-specific PLC commands cannot be used in the ladder program development for the CNC. 
The format, etc., are changed with some commands. Refer to "Appendix 1. DIFFERENCES IN 
DEVELOPMENT ENVIRONMENT BETWEEN PLC4B AND EZMotion-NC E60/E68" for details. 
 

 CAUTION    MELSEC-specific PLC commands cannot be used.  
 

(4)  Label at the beginning of ladder program 
 
In a EZMotion-NC E60/E68 ladder program, a processing unit is differentiated by specifying a 
reserved label number at the beginning of processing. There are the following different processing 
units.  

P251 : PLC high-speed processing program starting label 
P252 : PLC main processing program starting label 

If only the PLC main processing is to be performed, do not omit but describe the above label at the 
beginning of a ladder program. Unless the label is described, normal RUN cannot be performed. 
 

 CAUTION    Specify a label at the beginning of a ladder program. 
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(5)  Statements and notes 
 
GX Developer allows a ladder program to be commented (with interlinear statements and notes). 
They are available in two types: integrated and peripheral. 

Integrated type : Can be downloaded together with a ladder program to the CNC. 
Peripheral type : Cannot be downloaded. 

The integrated type cannot be used with the EZMotion-NC E60/E68. If it is used, a ladder program 
cannot be transferred to the CNC properly. 
 

 CAUTION    Do not use integrated type interlinear statements and 
notes. 

 
5.2  NC-Related Parameters 

 
Parameters in the NC side have bit selection parameters related to GX Developer. If an appropriate 
value is not set in the parameters, an error will occur in communication with GX Developer. 
 

 
 7 6 5 4 3 2 1 0
# (6451) Data (0 0 1 1 0 0 0 0)

 
 
 
 
                             [Reference]  #6451 corresponds to the low side of the file register R2925. 

 
[Note]  Turn the CNC power OFF after the parameter setting. 

Parameters are valid after the power is turned ON again. 
 

(a)  PLC environment selection 
 

Choose the GX Developer mode (bit4=1). 
[Note] The onboard will not start if the ladder format stored in the CNC is other than the GX 

Developer. 
 

Bit 4 = 0 
Not used for EZMotion-NC E60/E68. 

Bit 4 = 1 
The PLC development environment of GX Developer. 

 
(b)  GX Developer communication use selection 

 
Choose to use the serial port in GX Developer or in the other functions. 

 
Bit 5 = 0 

The serial port is not used for communication with GX Developer. 
(When the serial port is used for another function, set "0".) 

Bit 5 = 1 
The serial port is used for communication with GX Developer. 
At this time, the onboard function is not started if bit 4 = 1. 
This serial port cannot be used concurrently with the other function. 

 
 
 
 

0 : Not used for EZMotion-NC E60/E68. 
1 : GX Developer mode 

Use No. 6451. 
0 : GX Developer communication disabled 
1 : GX Developer communication enabled 
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5.3  PLC Data Storage Areas 
 
The EZMotion-NC E60/E68 stores PLC data onto flash ROM (hereafter abbreviated to the F-ROM). 
The following shows the storage area structure. 
 

Control information area

Non-ladder file storage
area Such as messages
and device comments

Ladder storage area

128 Kbyte

16 Kbyte

144 Kbyte

F-ROM (for storage)

Control information area

 
 
 

The data transferred from GX Developer are stored into the F-ROM area designed for both 
storage and execution. 

 
GX Developer Internal F-ROM  
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(1) Display of storage area on GX Developer 
 

Any of the storage areas that can be selected for the online functions (Write to PLC, Read from 
PLC, Verify with PLC) of GX Developer can be specified as a [Target memory] item on the 
corresponding operation screen. 
Also, pressing the [Title] button displays the comment of that storage area if PLC data exists. It 
is not displayed if the storage memory is not fitted or the data does not exist. 
Further, pressing the [Free space volume] button displays [Total free space volume] and 
[Largest continuous volume] of the selected area. 

 

 
 

Some storage areas displayed as the target memory differ from the actual storage areas of the 
CNC. The following tables indicates the relationships between the [Target memory] items and 
storage areas. 

 
Screen indication Meaning  Title indication Free area indication 
PLC RAM/Device 
memory 

Internal F-ROM ON BOARD F-ROM Target : All storage areas 
of Internal F-ROM 

IC Card A[RAM] Not used   
IC Card A[ROM] Not used   
IC Card B[RAM] Not used   
IC Card B[ROM] Not used   
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5.4  File Name 
 
Inside the EZMotion-NC E60/E68, PLC-related data are controlled and stored in the following 
categories. Therefore, they are also developed in the same categories. 
 

 CAUTION 
 If the data transferred does not follow the file name rule, the NC will mistake it 
for another data, resulting in unexpected operation, e.g. PLC program erasure. 

 

M1

Extensions .... Automatically attached with the GX Developer
(expresses f ile classif ication)

When data is transferred by GX Developer, its data type is distinguished by the file name.
An extension indicates a file type, and the first two characters denote a data type and a
language type.
xxxx can be specif ied within eight characters freely with the exception of the extension.

at the beginning of a file name are reserved on the NC side. Do not use the file name of this
combination.

File name rule

[Note]  Unusable f ile name

WPG or WCDxxxx.

Random file name .... User free designation

Data classif ication and language classif ication
(M1: Message 1st language)

.... User f ixed
     designation

Data type
Language type

: "M", "C" or "H" (alphabet)
: "0" to "9" (numeral)

 
 
 

List of PLC related data 
 
 

Related data classification 
File name 

(GX Developer) Remarks 

1
2 

PLC program (ladder) 
PLC program comment 

zzzzzz.WPG 
zzzzzz.WCD 

PLC ladder code 
Comment data for GX Developer 

3 Message 1st language M1xxxx.WPG Message 1st language data such 
as alarm messages/operator 
messages/PLC switches 

4 Message 2nd language M2xxxx.WPG Same as above 
(2nd language data) 
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1)  PLC program (ladder) 
 
• Ladder program developed using GX Developer. 
• Only one file can be stored in the NC. 
 

2)  PLC program comment 
 
• Program comment for GX Developer display 
• Only one file can be stored in the NC with the same file name as the ladder program. 
• A device comment (32 characters) and a device name (10 characters) can be defined for each 

device. 
• Stored mainly when it is read to GX Developer and used as a comment. 
 

3)  Message 1st language,  4)  Message 2nd language 
 
• Alarm message/operator message/PLC switch/comment message data. 
• One 1st language file and one 2nd language file can be stored in the NC. 
• The messages can be handled and edited as "integrated type interlinear statements" by GX 

Developer. 
• The maximum message length and the number of messages can be specified for each message 

type. 
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5.5  Specifying the Connection Target 
 
You must specify the connection target before performing online operations from GX Developer to 
the CNC. 
 

5.5.1  Operation procedure 
 
Perform the following operation from GX Developer to start the setting screen. 
 

[Online] → [Transfer setup] 
 
Set only the following items. Leave the other items unchanged from the initial values. 
 
1)  Personal computer side 
 

Interface     : [Serial interface] 
Serial port name : [COM1] or [COM2] 
Baudrate     : [19.2Kbps] 

 
2)  PLC side 
 

Interface     : [CPU unit] 
 

  Setting screen of SW4D5-GPPW 
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5.6  Starting/Stopping the PLC of the CNC 
 
Before writing a ladder program, you must stop the PLC of the CNC. 
 

5.6.1  Operation procedure 
 
Perform the following operation from GX Developer to start the operation screen. 
 

[Online] → [Remote operation] or  Alt  +  6  
 
On the following screen, set "STOP" or "RUN" in the [PLC] part under [Operation] and click 
[Execute]. The current status is displayed in [PLC status] under [Connection target information]. 
 

 
 
The operation is completed when the following dialog appears. Click [OK]. The status after 
completion appears in [PLC status] on the remote operation screen displayed behind. If the status 
does not change, check whether an alarm is displayed or not on the CNC side. 
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6.  PLC PROGRAM DEVELOPMENT 
 

This chapter mainly describes EZMotion-NC E60/E68-specific usage about the PLC program 
development procedure. 

 
6.1  Development Procedure 
 

There are the following two methods as a general development procedure of a PLC program. 
1)  Creating a new program using GX Developer. 
2)  Diverting the PLC program that was developed using the conventional MELDAS PLC 

programming tool (PLC4B). 
 

6.1.1  Creating a New Program 
 

For the way to create a new program, refer to the Operating Manual 
 
6.1.2  Diverting the PLC program that was developed using PLC4B 
 

 
 

1)  Creation 
The PLC program created with PLC4B is output in a list format. 

 
2)  Conversion 

Using CLST6L (ladder list converter), the output program is converted into a PLC program for 
EZMotion-NC E60/E68 (list format). Using GX Converter (data conversion software package), 
the list format program is converted into the GX Developer data. For the data conversion using 
GX Converter, refer to the section "6.6 Converting the Data Using GX Converter". 

 
3)  Editing/transfer 

The resultant program can be handled like a newly created PLC program. 
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6.2  Writing the PLC Program to the CNC 
 

The following indicates how to write ladders from GX Developer to the CNC (especially the 
restrictions and EZMotion-NC E60/E68-specific operations). 

 
6.2.1  Operation procedure 
 

Perform the following operation from GX Developer to start the operation screen. 
 

[Online] → [Write to PLC] 
 

On the following screen, choose the ladder file to be written from the [File selection] tab and click 
[Execute]. 
You can command RUN/STOP of the PLC using [Remote operation] under [Related functions]. 

 

 
 

[Note]  As [Target memory], only [PLC RAM/Device memory] is valid. 
Do not set the other tabs ([Device data], [Program], [Common], [Local]) than [File 
selection]. 

 
 
6.2.2  Writing operation 
 

When a ladder is written from the GX Developer to the CNC, the CNC converts it into the CNC-
specific ladder machine code. A conversion error occurs if any of the devices and command formats 
not supported by the CNC is used. Writing will not interrupted midway even if a conversion error 
occurs. A command in which an error occurs is converted into the "NOP" command (no processing 
command), and ladder up to the last step is transferred. 
After writing, a ladder is written in the flash ROM whether an error occurs or not. 
 
[Note]  A ladder on which an error occurs cannot be run because of security. 
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6.2.3  Operation to be performed at write error 
 
At a conversion error, the following dialog is displayed in the GX Developer screen. 
 

 
 
If you execute RUN the PLC as-is, an alarm occurs on the PLC side and the PLC does not run. 
 
When the ladder file that resulted in a conversion error is displayed with the [File selection] tab of 
the [Read from PLC] screen, the file name and the title are changed and displayed as below. 
When this ladder file is read into the GX Developer side, it is stored by the name of "ERRLAD-0". 
 

ERRLAD-0 <-- LDTEST : Convert ERROR.
(1) (2)

(2) Title including the name of
      the original transferred f ile

(1) File name during error

 
 
 

  

 CAUTION 
 Do not read a ladder file on which a conversion error occurred into the GX 
Developer side and use it. The file may include unexpected contents to result 
an illegal operation. 
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6.2.4  How to confirm the error step number 
 
The PLC verification function can be used to confirm the error step. For details on the PLC 
verification function, refer to "6.4 Verifying the PLC Programs". 
 
Verification source    : A transferred ladder file in the GX Developer side is selected. 
Verification direction  : An error occurrence ladder file "ERRLAD-0" in the CNC side is selected. 
 
 

 
 
 
Executing verification with PLC displays mismatches as in the following example. Following 
example shows the step where NOP command part of the CNC side becomes a conversion error. 
Double-click the mismatch to display and to edit the corresponding part of the file in the GX 
Developer side.  
<Memory> indicates the GX Developer side, and <PLC> the CNC side. 
 
 

 
 
 

GX Developer side CNC side 
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6.3  Reading the PLC Program from the CNC 
 
The following indicates how to read a ladder from the CNC to GX Developer. 
 

6.3.1  Operation procedure 
 
Perform the following operation from GX Developer to start the operation screen. 
 

[Online] → [Read from PLC] 
 
On the following screen, choose the ladder file to be read from the [File selection] tab, and click 
[Execute]. 
 

 
 

[Note]  As [Target memory], the fitted memory is valid. 
Do not set the other tabs ([Device data], [Program], [Common], [Local]) than [File 
selection]. 

 
If a ladder file with the same name already exists in the GX Developer side, following dialogue will 
appear. 
 

 
 

[Note]  Choosing [Yes (Y)] in the dialogue will overwrite the GX Developer side ladder file. The 
file before overwriting will be erased. 
Confirm the file enough before choosing [Yes (Y)]. 
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The [Read from PLC] screen can also be used as a CNC side file listing function. Move the scroll 
bar of the [File selection] tab to the right to display the write date and size of each file. Click [Free 
space volume] to display the free area of the target memory. 
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6.4  Verifying the PLC Programs 
 
The following indicates how to verify ladders between the CNC and GX Developer. 
 

6.4.1  Operation procedure 
 
Perform the following operation from GX Developer to start the operation screen. 
 

[Online] → [Verify with PLC] 
 
On the following screen, choose the ladder files to be verified from the [File selection] tab, and click 
[Execute]. 

[Verify source] : GX Developer side      [Verify dest] : CNC side 
 

 
 

[Note]  As [Target memory], the fitted memory is valid. 
Do not set the other tab ([Program], [Device data]) than [File selection]. 

 
If verification mismatches occur, the following mismatch screen appears. Double-click the mismatch 
to display the corresponding part of the GX Developer side file. 
 

 

GX Developer side CNC side 
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6.5  Monitoring the PLC Program 
 
There are no EZMotion-NC E60/E68-specific operations to monitor a PLC program. Refer to the 
operating manual for the operation methods. For usable functions, refer to "3.2 Function Support 
Conditions (on-line section)". This section explains the operation procedure outline and precautions. 
 

6.5.1  Operation procedure 
 
Perform the following operation from GX Developer to start monitoring. 
 

(1) Display the ladder program to be monitored and move to the circuit part to be monitored. 
 
(2) Perform the following operation to start monitoring. 
 

[Online] → [Monitor] → [Monitor mode] or  F3   
 
(3) Perform the following operation to stop monitoring. 
 

[Online] → [Monitor] → [Stop monitor] or  Alt  +  F3   
 

 CAUTION 
 If the ladder program being run by the CNC differs from the one being 
displayed on GX Developer, monitoring will not result in an error but will 
continue. 
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6.6  Converting the Data Using GX Converter 
 
Convert the ladder list, which was converted using a ladder list converter or like, into GX Developer 
data in the following method. Use "GX Converter (data conversion software package)" for 
conversion. GX Converter can be started from the GX Developer menu. 
 

6.6.1  Starting GX Converter and specifying the file to be converted 
 
Perform the following operation from GX Developer to start GX Converter (read). 
 

[Project] → [Import file] → [Import to TEXT ,CSV format file] 
 
On the following screen, choose the file to be converted (LDTEST.TXT) and click [OK]. 
 

 
 
 

6.6.2  Conversion format setting 
 
Set the conversion format on the following data conversion wizard screen. 
 
1)   Data conversion wizard 1/4 
 

Choose [Original Data Type]-[Delimited] and [Data Type]-[List], and click [Next>]. 
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2)  Data conversion wizard 2/4 
 

Choose [Delimiters]-[Tab] and click [Next>]. 
 

 
 
3)  Data conversion wizard 3/4 
 

Choose to highlight the Command column part in the [Data Preview] list and choose [Column 
Data Format]-[Instr]. 

 

 
 
4)  Data conversion wizard 3/4 
 

Further, choose to highlight the Argument column part in the [Data Preview] list and choose 
[Column Data Format]-[I/O(Device)]. Click [Next>]. 
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5)  Data conversion wizard 4/4 
 

Set the program name used on GX Developer at [Data name] column and a ladder annotation 
at [Title] column, and click [Finish]. 

 

 
 
6)  Completion 
 

The setting is complete when the following completed dialog appears after the converting dialog. 
Click [OK]. 
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7.  PLC MESSAGE DEVELOPMENT 
 

This chapter describes a procedure for developing PLC-related data such as alarm messages, 
operator messages, and PLC switches. 

 
7.1  Development Procedure 
 

There are the following two methods as a general development procedure of message data. 
 

1)  Making conversion into GX Developer data using a general text editor or spreadsheet tool and 
data conversion package.  
(When there is a large volume of message data and you want to control them with a 
commercially available tool, for example) 

 
2)  Entering messages directly from GX Developer 

(When there is a small volume of message data or when addition or correction is to be made, for 
example) 

 

 
 
 



7. PLC MESSAGE DEVELOPMENT 
7.1 Development Procedure 

 

 - 34 -

7.1.1  Using a general text editor 
 

1)  Creation 
 
The message data is described using a general text editor. The description method and format 
will be described later. 

 
2)  Conversion 

 
The conversion from text data to GX Developer data is carried out using the "GX Converter 
(data conversion software package)". 

 
3)  Transfer 

 
With the GX Developer, the message data is handled as a PLC program interlinear comment, 
and can also be edited. 
The message data is transferred to the CNC using the GX Developer, in the same manner as 
the ladder program. 

 
7.1.2  Entering messages directly from GX Developer 
 

1)  Creation 
 
The message data is described directly from GX Developer. The message data is handled as a 
PLC program interlinear comment by GX Developer. The description method and format will be 
described later. 

 
2)  Transfer 

 
The message data is transferred from GX Developer to the CNC in the same manner as the 
ladder program. 
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7.2  Message Data Description Method 
 
The message data can be described as text data by a general text editor and also by commercially 
available spreadsheet software in addition to the direct input with GX Developer. 
 

7.2.1  Description Format 
 
Message data is classified into setting areas to store the setting for each message and message 
areas to store message data. It is described in the following respective description format. 
 
1)  Setting area 
 

The message length and No. of messages are set for each message in the setting area. The 
message data region secured by the CNC can be adjusted to the most efficient status using 
these settings. The respective maximum values are set if nothing is set. (Refer to "7.2.3 
Precautions" for the maximum values.) 

 
;$, message classification code, maximum message length, No. of messages [CR] 

 
2)  Message area 
 

The message area is described using the following description format. 
The description format cannot be abbreviated. Comma(,) and [CR] must be described, even the 
message character string is blank. 

Message classification Description format 
Alarm message ;A, index No., data register No., message character string [CR] 
Operator message ;O, index No., data register No., message character string [CR] 
PLC switch ;P, switch No., message character string [CR] 
Comment message ;M, device, device No., message character string [CR] 

 
Message classification 
  code 
Index No. 
Switch No. 
Data register No.  
Device 
Device No. 
Message character 
  string 
 
 
Semicolon( ; ) 
Comma( , ) 
 
[CR] 

: A one-byte alphabetic character expressing each message 
classification 

: One-byte number (0 to No. of messages in the setting area - 1) 
: One-byte number (0 to No. of messages in the setting area - 1) 
: One-byte number 
: One-byte number (1 or 2) 
: One-byte number (0 to 10) 
: One-byte alphanumeric character, shift JIS Code 1 character, No. 

of characters in the setting area message length. 
Semicolons, commas, spaces and tabs can also be used. Note that 
the tab at the head of the message character string is ignored. 

: Message data identification code 
: Separator between each description (a comma only is used to leave 

a message character string blank) 
: Line feed code, (CR/LF) or (LF). 
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7.2.2  Description Method 
 

The message data is described as text data by the following description format. 
 

 
 
 

1)  Comment 
 
Statements having a semicolon (;) at the head of the line, in a different format than described in 
"7.2.1 Description format", are regarded as comments. These comments are handled as 
comment data in the GX Developer also, but are erased during the transfer to the CNC. An error 
will occur if there is no semicolon at the head of the line. 

 
2)  Setting area 

 
Each message is set here. This area must be described before the message area of the 
relevant message. That setting will be ignored if it is described in the middle of or after the 
relevant message description. 

 
3)  Message area 

 
Collect similar messages in a group and describe them. There is no description order in the 
respective messages, but the latter description is validated if there are descriptions with the 
same factors (index No., etc.). 

 
4)  Page break code 

 
A page break code is described at one or more places approx. every 15 lines in the setting area 
and message area. The message data may skip if there is no page break code. 
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5)  End code 
 
An end code is described at the end of the description. Description after the end code are 
ignored. 
An error will occur if there is no end code. 
 

7.2.3  Precautions 
 

No. of characters, quantity limitations, handling of information other than settings, handling of 
information other than format are described below. 

 
1)  Message data maximum value 

 
Processing will be carried out with the following values considered as the maximum values if the 
setting is not carried out in the setting area, or if the description position in the setting area is 
illegal. 

 

Message 
classification 

Max. message 
length 

Max. No. of 
messages 

Data size by multiplying 
max. message length by 
max. No. of messages 

Alarm messages 32 byte 512 16 Kbyte 
Operator messages 60 byte 512 30 Kbyte 
PLC switches 14 byte 32 0.5 Kbyte 
Comments 60 byte 100 6 Kbyte 

 
[Note]  Two-byte data in the message character string is handled as two characters. 

GX Developer accepts 64 characters as an interlinear comment. However, since that 
includes information other than a message character string (e.g. message classification 
code, index No. and data register No.), the message character string is actually up to 
58 characters long. 

 
2)  When the setting value and message data do not match 

 
When the message data contents (such as index No, switch No. and message character string) 
overflows from the settings in the setting area, the data that overflowed is ignored. 
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7.3  Converting Data into GX Developer Format 
 
Convert the message data, which was described using a text editor or like, into GX Developer data 
in the following method. Use "GX Converter (data conversion software package)" for conversion. 
GX Converter can be started from the GX Developer menu. 
 

7.3.1  Starting GX Converter and specifying the file to be converted 
 
Perform the following operation from GX Developer to start GX Converter (read). 
 

[Project] → [Import file] → [Import from TEXT ,CSV format file] 
 
On the following screen, specify the file to be converted (M1TEST.TXT) and click [OK]. 
 

 
 

7.3.2  Conversion format setting 
 
Set the conversion format on the following data conversion wizard screen. 
 
1)  Data conversion wizard 1/4 
 

Choose [Original Data Type]-[Fixed Width] and [Data Type]-[List], and click [Next>]. 
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2)  Data conversion wizard 2/4 
 

Just click [Next>]. 
 

 
 
3)  Data conversion wizard 3/4 
 

Choose to highlight the command column part in the [Data Preview] list and choose [Column 
Data Format]-[Instruction ,Statement ,Note]. Click [Next>]. 

 

 
 
4)  Data conversion wizard 4/4 
 

Set the program name used on GX Developer in [Data name] and a data annotation in [Title], 
and click [Finish]. The setting is complete when the completed dialog appears. Click [OK]. 
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7.4  Entering/Editing Data Using GX Developer 
 
The message data in GX Developer are handled as the "integrated type interlinear statements" of a 
PLC program. "Integrated type interlinear statements" are interlinear comments provided to assist 
the understanding of the PLC program, and those transferred to the CNC together with the PLC 
program are called the "integrated type". 
"Interlinear statements" can be displayed and edited using [Ladder] or [Instruction list]. 
 

7.4.1  Interlinear statement display using circuit display 
 
1)  Display of project data list 
 

Perform the following operation to display the Project data list window and double-click the file 
name to display the edit screen. First, the normal ladder screen appears. 

 
[View] → [Project data list], then double-click [File name you want to display]. 

 
2)  Display of message data 
 

Perform the following operation to display the message data that are integrated type interlinear 
statements. 

 
[View] → [Statement] 
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7.4.2  Interlinear statement display using list display 
 
1) Display of project data list 
 

Perform the following operation to display the Project data list window and double-click the file 
name to display the edit screen. First, the normal ladder screen appears. 

 
[View] → [Project data list], then double-click [File name you want to display]. 

 
2)  Display of list data 
 

Perform the following operation to display the list data. The list display also shows the message 
data that are integrated type interlinear statements. 

 
[View] → [Instruction list] 

 
Perform the following operation to return to the circuit display. 

 
[View] → [Ladder] 
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7.4.3  Editing of integrated type interlinear statements 
 
1)  Circuit display 
 

On the circuit display screen that shows the integrated type interlinear statements, double-
clicking the interlinear statement you want to edit displays the following dialog. Perform editing 
operation on the dialog and click [OK] or press [Enter]. 

 

 
 
2)  List display 
 

On the list display screen, double-clicking the interlinear statement you want to edit displays the 
following dialog. Perform editing operation on the dialog and click [OK] or press [Enter]. 

 

 
3)  Entering new message data 
 

• Displaying new edit screen 
 

Perform the following operation to display the [New] dialog, and set the [Data name] and 
[Title]. After setting, click [OK]. 

 
[Project] → [Edit Data] → [New] 

 

 
• Changing to list display mode 

 
Perform the following operation to display the list data.  

 
[View] → [Instruction list] 

 
• Entering message data 

 
Press "Enter" on the "END" line, enter data as in the section above "List display", and then 
press "Enter" on the next line and enter message data.  
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7.5  Writing to the CNC 
 
The following shows the method of transferring a message from the GX Developer to the CNC. The 
transfer method is the same as the ladder code transfer method. Ladder codes and message data 
are distinguished by their file names only. 
Perform the following operation to display the [Write to PLC] screen, and choose the file to be 
written. 
 

[Online] → [Write to PLC] 
 
The following example transfers a message first language file "M1TEST.GPG". 
 

 
 
 
[Note]  Restrictions for writing message data 

As for message data, only the same file name can be rewritten. 
The following error dialog is displayed if the message data having the different name in the 
same classification is rewritten. (Example: When the message file "M1DATA" is rewritten to 
"M1TEST".) 
 

 
 
In such case, delete the corresponding file in the CNC first, and then execute writing. 
(It is not necessary to execute the format.) 
The deletion screen is displayed by the following operation. For details, refer to the 
Operating Manual. 
 

[Online] → [Delete PLC data] 
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7.6  Reading and Verifying from the CNC 
 
The following shows the method of reading and verifying a message from the CNC to the GX 
Developer. The method of reading and verifying is the same as that of ladder codes. Ladder codes 
and message data are distinguished by their file names only. 

 
7.6.1  Menu Selection/Screen Operation 

 
Refer to the following sections for operation methods. 

For read    : "6.3 Reading the PLC Program from the CNC" 
For verification : "6.4 Verifying the PLC Programs" 

 
7.6.2  Message Read Format 

 
The message description format was shown in "7.2.1 Description format", but there are no special 
rules concerning provision of descriptions in the setting area or the order of message description in 
the message area. For that reason, the description format may differ between transfer and reading 
of the message data. 
The following shows the format during reading as the "Standard description format". 
 

Standard description format of message data 
 

Alarm message setting 
Operator message setting 
PLC switch setting 
Comment message setting 
Alarm messages 
Operator messages 
PLC switches 
Comment messages 
NOPLF 
END 

…(1) 
 
 
 
…(2) 
…(3) 
…(4) 
…(5) 

 
(1)  Setting area 

 
The settings are described in order of alarm, operator, PLC switch and comment. 
The maximum value is described if the setting is abbreviated. 

 
(2)  Alarm messages 

 
Each message data is described in order of the index Nos. 

 
(3)  Operator messages 

 
The same as the alarm messages. 

 
(4)  PLC switches 

 
Each message data is described in order of the switch Nos. 

 
(5)  Comment messages 

 
These messages are described in the same order as described before transfer. 

 
(6)  Others 

 
• Spaces and tabs are not included before and after the comma(,) separating the message data 

factors. 
• The message character string is handled the same as normal data even when blank. 
• The NOPLF code between messages is described to the position to which the message data 

following the NOPLF code during transfer moved. 
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8.  DEVICE COMMENT CREATION 
 

There are no EZMotion-NC E60/E68-specific operations for device comments. Therefore, refer to 
the operating manual for the development method. This section describes the device comment 
development procedure outline and the development method using a general-purpose tool. 

 
8.1  Development Procedure 
 

There are the following two methods as a general development procedure of device comments. 
 

1)  Indirect entry 
 

In this method, device comments are converted into GX Developer data using a general text 
editor or spreadsheet tool and data conversion package. Use this method when you want to 
divert the device comments of PLC4B or when a device comment volume is large and you want 
to control them with a commercially available tool, for example. 
 

Conversion
GX Converter

Editing
GX Developer

ladder
zzzz. WPG

device
comment

zzzz.W CD

device
comment
zzzz.TXT

CNC

Creation
Spreadsheet tool

Text editor

IBM PC/AT compatible personal computer

EZMotion-NC E60/E68

EZMotion-NC E60/E68

EZMotion-NC E60/E68

 
 

2)  Direct entry 
 
In this method, device comments are entered directly from GX Developer. Use this method 
when a device comment volume is small or when addition or correction is to be made, for 
example. 
There are the following three methods for direct entry from GX Developer. Refer to the 
operating manual for details. 
 

• Creating comments on the device comment edit screen 
• Creating device comments after circuit creation during ladder circuit creation 
• Making addition/correction to device comments in the created ladder circuit 
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8.2  Description Method for Indirect Entry 
 
The following explains the description method for creating device comments using a spreadsheet 
tool or like. The following example describes device comments using a spreadsheet tool. 
 

Describe device, equipment
name and comment on the
same line.

Device-
only
column

Equipment
name-only
column

Comment-
only
column

Safety unit run
Safety cover close
Operation ready complete
Oil pressure motor

Parts A ready complete

 
 
 
Column data format Explanation 
Device (1) Describe a device. 

• Conversion cannot be made if a device has not been described. 
Always describe a device.  

(2) A device is a required item. Describe it in one-byte code. 
Comment (1) Describe a comment. 

• It is not registered if the device part on the same row is blank or the 
device is illegal. 

(2) You can describe a comment of up to 32 characters. 
Equipment name (1) Describe an equipment name. 

• It is not registered if the device part on the same row is blank or the 
device is illegal. 

(2) You can describe an equipment name of up to 8 characters. 
 
[Note]  Describe data in any of the following combinations. 

(1) Device, equipment name, comment 
(2) Device, comment 
(3) Device, equipment name 
 

Save the above data in the CSV format. The following example shows the above data saved in the 
CSV format. 
 

 
X0, SAFETY, Safety unit run 
X1, COVER, Safety cover close 
X2, READY, Operation ready complete 
X3, OIL-M, Oil pressure motor 
X4, PARTS-A, Parts A ready complete 
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8.3  Converting Comment Data into GX Developer Data 
 
Convert the comment data (CSV format), which was created using a spreadsheet tool or like, into 
GX Developer data in the following method. Use "GX Converter (data conversion software 
package)" for conversion. GX Converter can be started from the GX Developer menu. 
 

8.3.1  Starting GX Converter and specifying the file to be converted 
 
Perform the following operation from GX Developer to start GX Converter (read). 
 

[Project] → [Import file] → [Import from TEXT ,CSV format file] 
 
On the following screen, specify the file to be converted (cmnt_all.txt) and click [OK]. 
 

 
 

8.3.2  Conversion format setting 
 
Set the conversion format on the following data conversion wizard screen. 
 
1)  Data conversion wizard 1/4 
 

Choose [Original Data Type]-[Delimited] and [Data Type]-[Comment], and click [Next>]. 
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2)  Data conversion wizard 2/4 
 

Choose [Delimiters]-[Tab] and click [Next>]. 
 

 
 
3)  Data conversion wizard 3/4 
 

Make sure that the column parts in the [Data Preview] list are in order of [Device Number], 
[Label] and [Comment], and click [Next>]. 

 

 
 
4)  Data conversion wizard 4/4 
 

Choose [Data type]-[Common comment] or [Program comment], set the comment file name 
used on GX Developer in [Data name] and a comment annotation in [Title], and click [Finish]. 
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5)  Completion 
 
The setting is complete when the following dialog appears. Click [OK]. 
 

 
 

6)  Error status 
 
If an error occurred during conversion, its status and the line where it occurred are displayed. 
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9.  RELATIONSHIPS BETWEEN GX Developer AND ONBOARD 
FUNCTIONS 

 
The CNC has onboard functions as the PLC development environment that does not use GX 
Developer. The onboard functions have monitoring and editing functions for ladder program testing 
and adjustment. 
This chapter explains the items related to GX Developer and onboard functions. 

 
9.1  Function Differences 
 

The onboard functions do not have the following functions among the main functions as the PLC 
development environment. 

 
• Function to create a new ladder program 
• All PLC message-related functions 
• All device comment-related functions 

 
9.2  Specification Differences 
 

There are the following differences in specifications between GX Developer and onboard functions. 
 

(1)  Restriction specifications related to circuit display/editing 
 

The restriction specifications related to circuit display/editing differ between GX Developer and 
onboard functions. Since the restriction specifications of the onboard functions are narrower 
than those of GX Developer, care should be taken when creating a circuit on the GX Developer 
side. 

 
(a)  Restriction specifications 

 Onboard GX Developer 
Number of 
contacts 

8 contacts, 1 coil 11 contacts, 1 coil 
Display 
specifications 
of single screen 

Number of 
lines 

9 lines 
 

Depending on window 
size and screen reduction 
ratio 

Restriction specifications of 
single circuit 

18 lines (return count: 0) 
(Note 1) 

24 lines of 200 or more 
series contacts 

 
(Note 1)  The relationships between the return count and the maximum value of the vertical 

width of the circuit that can be created at that time are as follows. 
Return count (times) 0 1 2 3 4 5 6 7 8
Vertical width of circuit (lines) 18 11 7 5 4 3 3 2 2

Excess over the above will result in "LADDER ERROR". 
 

(b)  Handling of the circuit that exceeds the restriction specifications 
 
If the circuit created on the GX Developer side exceeds the circuit restriction specifications 
of the onboard functions, the following message is displayed. 

Operation Message Handling 
When "read" or "monitor" function 
is used to display circuit 

"DISPLAY OVER FLOW" Circuit is not displayed. 
(Only bus is displayed) 

When "write", "insertion", 
"deletion" or "conversion" function 
is selected 

"NOT WRITE" Editing operation is 
inhibited. 
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(2)  Step count calculation specifications 
 

The step count specifications in the individual commands of the MELSEC and EZMotion-NC 
E60/E68 differ in some commands. Therefore, steps may be different when the same circuit is 
displayed by GX Developer and onboard functions. 
This will give rise to a problem especially when the circuit diagram printed from GX Developer 
is used for maintenance with the onboard functions. To resolve this problem, a tool (PCNV6LM) 
to print a circuit diagram in the EZMotion-NC E60/E68 step specifications is available. 

 
(3)  Command character string display specifications 
 

The commands of the EZMotion-NC E60/E68 original specifications that cannot be handled by 
GX Developer are used after they have been replaced by the substitute commands that can be 
handled by GX Developer. When these commands are displayed by the onboard functions, the 
specifications are as indicated below. 
 

Classification Command 
symbol Onboard display GX Developer display 

Bit DEFR ⎯[ DEFR  D ]⎯ 
      D 
⎯   ↑   ⎯ 

Average value AVE ⎯[ AVE  S  D  n ] ⎯[ S.AVE  S  D  n ] 

Carry flag set STC ⎯[ STC ] ⎯[ S.STC ] 

Carry flag reset CLC ⎯[ CLC ] ⎯[ S.CLC ] 

ATC ATC ⎯[ ATC Kn Rn Rm Mm ] ⎯[ S.ATC  Kn  Rn  Rm  Mm ] 

ROT ROT ⎯[ ROT Kn Rn Rm Mm ] ⎯[ S.ROT  Kn  Rn  Rm  Mm ] 

TSRH TSRH ⎯[ TSRH  Rm  Rn  Mn ] ⎯[ S.TSRH  Rm  Rn  Mn ] 

DDBA DDBA ⎯[ DDBA  Rn/Dn ] ⎯[ S.  DDBA  Rn/Dn] 

DDBS DDBS ⎯[ DDBS  Rn ] ⎯[ S.  DDBS  Rn ] 

CAL1 CAL1 ⎯[ CAL1  Pn  ] ⎯[ S.  CAL1  Pn ] 

LDBIT [ < =   S1  n ]⎯ [ < =  S1  n ]⎯ 

ANDBIT ⎯[ < =   S1  n ]⎯ ⎯[ < =  S1  n ]⎯ 

ORBIT [ < =   S1  n ] [ < =  S1  n ] 

LDBII [< >  S1  n ]⎯ [ < >  S1  n ]⎯ 

ANDBII ⎯[ < >  S1  n ]⎯ ⎯[ < >  S1  n ]⎯ 

BIT 

ORBII [ < >  S1  n ] [ < >  S1  n ] 
 

 
(4) Circuit representation specifications 
 

The circuit of the END command is not displayed by the onboard functions. 
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10.  ERROR STATUS 
 
10.1  GX Developer Errors 
 

If an error has occurred in GX Developer, the following dialog appears. The error message and error 
status are displayed in the dialog. 

 
 

(2) Error status 

(1) Error message 

  

 CAUTION 
 When an error occurred at GX Developer On-line function, the error message 
may not explain exactly the state in the CNC side. 
Always refer to the error list. 

 
The following table indicates the causes and remedies of the errors that can occur during online 
operation with the CNC. For other errors, refer to the operating manual. 
 
Status Message Cause Remedy 
4002 The executed function is not 

supported. 
An operation outside the 
specification was performed. 

Check the operation 
procedure. 

4010 The PLC is in RUN mode, so 
writing cannot be done. 

The PLC of the NC is running. After stopping the PLC of the 
NC, start execution again. 

4021 The applicable drive is not 
ready. 

The specified target memory 
does not exist or is not in a 
usable status. 

Change the target memory. 

4029 Insufficient file capacity. An attempt was made to write 
a file that exceeds the storage 
capacity. 

Examine the file structure that 
falls within the limited capacity.

402b The file cannot be accessed. An attempt was made to write 
the same type of file. 

After deleting the same type of 
file from the NC side, start 
execution again. 

4031 The specified device No. 
exceeds the permissible range.

The access request given is 
outside the accessible device 
range. 

Check the number range of 
each device. 

4052 The file is write protected. The specified target memory is 
a write-disabled device  
(F-ROM). 

Specify "internal RAM" as the 
target memory. 

4053 Writing to the flash ROM failed. An error occurred in the 
process to erase or to write 
data into the flash ROM. 

Perform initialization for the 
PLC data storage area. 
If the normal state is not 
recovered in spite of remedies, 
the hardware may have 
inferiority or deterioration 
aspects. Contact our system 
department. 
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Status Message Cause Remedy 
4070 The program before correction 

differs from the registered 
program. 

A ladder command outside the 
specification is included. 

Perform verification to identify 
the command that is the cause 
of the problem. 

When the "Read from PLC" or 
"Verify with PLC" is executed 
(CNC -> PLC): 

The data outside the 
specification is included in 
the specified file. 

A ladder or message in the 
CNC side may be damaged. 
Delete the corresponding file to 
retry, or perform initialization 
for the PLC data storage area. 
If the normal state is not 
recovered in spite of remedies, 
contact our system 
department. 

4080 Incorrect abnormal. 

When the "Write to PLC" is 
executed (PLC -> CNC): 

Two or more END 
commands are included in 
the specified ladder file. 

Edit the ladder program in the 
list mode to delete END 
commands except only one at 
the last line. 

8201 Cannot communicate with the 
PLC. 

The communication cable is 
faulty. 
• Not connected 
• DTR signal off 

Check the serial port setting 
and cable connection. 

840b Cannot communicate with PLC 
for one of the following 
reasons. 

There is no response from the 
NC. 
• The NC has not started 

properly. 
• The connection channel of 

the NC side serial port is 
different. 

• The serial cable outside the 
specifications is used for 
signal connection. 

Check the following. 
• CNC side status 
• Cable connection 
• Bit selection  

: GX Developer 
communication valid 

 
[Note]  For "PLC" in the message, read "CNC". 
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10.2  Initialization for PLC Data Storage Area  
 

When an error has occurred during writing to the CNC, or when the normal state is not recovered in 
spite of error handling, perform initialization for the PLC data storage area, and retry from the first. 
 
[Note]  When this operation is performed, all ladders and messages currently stored in the CNC are 

erased. Do not use this operation other than when the error cannot be solved. 
 

10.2.1  Operation procedure 
 
Perform the following operation from GX Developer to start the operation screen. 

[Online] → [Format PLC memory] 
 
On the following screen, click [Execute]. 
 

 
 
 
[Note]  As [Target memory], only "PLC RAM/Device memory" is valid. 

The setting is not necessary for [Format Type]. 
 
 
The setting is completed when the following dialog appears. Click [OK]. All data stored in the F-
ROM have been deleted and initialized. 
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APPENDIX 1.  DIFFERENCES IN DEVELOPMENT ENVIRONMENT 
BETWEEN PLC4B AND EZMotion-NC E60/E68 

 
This section explains differences between the PLC4B development environment and EZMotion-NC 
E60/E68 PLC development environment. 

 
Appendix 1.1  Development Tools, etc. 

 
In the EZMotion-NC E60/E68, a user PLC development environment that used the MELSEC PLC 
development tool was constructed. Consequently, the tools used at each development process 
differ. A comparison of each process is shown in "Table 1.1 List of development tool comparisons". 
Refer to the respective lnstruction Manuals for details on each tool. 
 

Table 1.1 List of development tool comparisons 
Development 

process 
 PLC4B development environment MELSEC PLC development 

environment 
List -> ladder 
conversion 

Tool  
 
Hardware 

PLC development software  
(list section) (LIST4B)  
PC9801/PC-AT 

GX Converter 
 
PC-AT 

Ladder creation  
 

Tool  
 
Hardware 

PLC development software  
(ladder section) (PLC4B)  
PC9801/PC-AT 

GX Developer 
  
PC-AT 

Message creation Tool  
 
Hardware 

PLC development software  
(ladder section) (PLC4B) 
PC9801/PC-AT 

Text editor -> GX Converter -> 
GX Developer 
PC-AT 

Transfer to the CNC Tool  
 
Hardware 

PLC4B <-> RS-232C <-> controller  
 
Via RS-232C 

GX Developer <-> RS-232C <-> 
CNC 
Via RS-232C 

Tool (1) 
Hardware 

 GX Developer 
PC-AT <-> CNC  

Monitor 

Tool (2)  
Hardware 

PLC onboard (ONBD)  
controller 

PLC onboard 
CNC  

ROM writing Tool 
Hardware 

PLC onboard -> F-ROM 
controller 

I/O screen -> F-ROM 
CNC  

Tool (1)  
 
Hardware 

PLC development software  
(ladder section) (PLC4B)  
PC9801/PC-AT 

GX Developer 
 
PC-AT 

Print output 

Tool (2) 
Hardware 

PLC onboard (ONBD)  
controller 
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Appendix 1.2  Devices and Device Assignments 
 
PLC4B and GX Developer differ in the devices and assignments used for the user PLC 
development. 

Table List of device differences 

PLC4B device No.  GX Developer device No. Remarks 
X X0 to X4BF -> X0 to X4BF  
U U0 to U17F -> X4C0 to X63F Not used 
I I0 to I3FF -> X640 to XA3F Not used 
S S0 to S1F -> XA40 to XA5F Not used 
S S40 to S5F -> XA60 to XA7F Not used 
S S80 to S9F -> XA80 to XA9F Not used 
S SC0 to SDF -> XAA0 to XABF 

X 

Not used 
Y Y0 to Y53F -> Y0 to Y53F  
W W0 to W1FF -> Y540 to Y73F Not used 
J J0 to J63F -> Y740 to YD7F Not used 
S S20 to S3F -> YD80 to YD9F Not used 
S S60 to S7F -> YDA0 to YDBF Not used 
S SA0 to SBF -> YDC0 to YDDF Not used 
S SE0 to SFF -> YDE0 to YDFF 

Y 

Not used 
M M0 to M5119 -> M0 to M5119  
G G0 to G3071 -> M5120 to M8191 

M 
 

F F0 to F127 -> F0 to F127 F  
L L0 to L255 -> L0 to L255 L  
E E0 to E127 -> SM0 to SM127 SM  
T T0 to T15 -> T0 to T15 10ms timer 
Q Q0 to Q39 -> T16 to T55 10ms timer (fixed timer) 
T T16 to T95 -> T56 to T135 100ms timer 
Q Q40 to Q135 -> T136 to T231 100ms timer (fixed timer) 
T T96 to T103 -> T232 to T239 100ms integrated timer 
Q Q136 to Q151 -> T240 to T255 

T 

100ms integrated timer (fixed timer) 
C C0 to C23 -> C0 to C23  
B B0 to B103 -> C24 to C127 

C 
 

D D0 to D1023 -> D0 to D1023 D  
R R0 to R8191 -> R0 to R8191 R  
A A0, A1 ->   Discontinued (replaced by D, R registers)
Z Z -> Z0  
V V -> Z1 

Z 
 

N N0 to N7 -> N0 to N7 N  
P P0 to P255 -> P0 to P255 P  
K K-32768 to K32767

K-2147483648 to 
K2147483647 

-> 
K-32768 to K32767 
K-2147483648 to 

K2147483647 
K 

 

H H0 to HFFFF 
H0 to HFFFFFFFF -> H0 to HFFFF 

H0 to HFFFFFFFF H  
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Appendix 1.3  PLC Commands 
 
The EZMotion-NC E60/E68 and the GX Developer differ in usable types and numbers of PLC 
commands. 
Differences are classified into the three following types. 

• Commands that cannot be handled with the GX Developer 
• Commands that the format differs from that of the GX Developer  
• Commands that can be used by the GX Developer, but cannot be used by the EZMotion-NC 

E60/E68 
 

Appendix 1.3.1  Commands that cannot be Handled with the GX Developer 
 
Commands that cannot be handled with the GX Developer are substituted with alternate commands 
that can be handled with the GX Developer. Commands that can be alternated are shown in "Table 
1.3.1 Table of alternate command correspondence". 
When some commands described in "Table 1.3.1 Table of alternate command correspondence" are 
created with the GX Developer  with the EZMotion-NC E60/E68 command sign left as is, an error 
results and creation cannot be carried out. Create the commands using the GX Developer 
command sign described in the correspondence table. 
When PLC programs containing alternate commands are written from the GX Developer to the 
EZMotion-NC E60/E68, they are rewritten to the EZMotion-NC E60/E68 commands. 
 

Table 1.3.1 Table of alternate command correspondence 
 EZMotion-NC E60/E68 command GX Developer command 

Classification Command 
sign Symbol Command 

sign Symbol 

Bit DEFR ⎯[ DEFR  D ]⎯ ANDP 
      D 
⎯   ↑   ⎯ 

Average value AVE ⎯[ AVE  S  D  n ] S.AVE ⎯[ S.AVE  S  D  n ] 
Carry flag set STC ⎯[ STC ] S.STC ⎯[ S.STC ] 
Carry flag reset CLC ⎯[ CLC ] S.CLC ⎯[ S.CLC ] 
ATC ATC ⎯[ ATC Kn Rn Rm ]-< Mm > S.ATC ⎯[ S.ATC Kn Rn Rm Mm ] 
ROT ROT ⎯[ ROT Kn Rn Rm ]-< Mm > S.ROT ⎯[ S.ROT Kn Rn Rm Mm ] 
TSRH TSRH ⎯[ TSRH  Rm Rn ]-< Mn > S.TSRH ⎯[ S.TSRH Rm Rn Mn ] 
DDBA DDBA ⎯[ DDBA Rn / Dn ] S.DDBA ⎯[ S.DDBA Rn / Dn ] 
DDBS DDBS ⎯[ DDBS Rn ] S.DDBS ⎯[ S.DDBS Rn ] 
CAL1 CAL1 ⎯[ CAL1 Pn ] S.CAL1 ⎯[ S.CAL1 Pn ] 

LDBIT [ BIT  S1  n ]⎯ LD<= [ < =  S1  n ]⎯ 
ANDBIT ⎯[ BIT  S1  n ]⎯ AND<= ⎯[ < =  S1  n ]⎯ 
ORBIT [ BIT  S1  n ] OR<= [ < =  S1  n ] 
LDBII [ BII  S1  n ]⎯ LD<> [ < >  S1  n ]⎯ 
ANDBII ⎯[ BII  S1  n ]⎯ AND<> ⎯[ < >  S1  n ]⎯ 

BIT 

ORBII [ BII  S1  n ] OR<> [ < >  S1  n ] 
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Appendix 1.3.2  Commands with the Format that Differs from that of the GX Developer 
 
The EZMotion-NC E60/E68 and the GX Developer differ in the device types and assignments. 
The format of the EZMotion-NC E60/E68 "commands used by inputting or outputting an 
accumulator (A0, A1)" is changed so that the general word register can be designated with 
arguments without fixing by A0 or A1 input or output. 
Format-changed commands are shown in "Table 1.3.2 Table of format-changed command 
correspondence". 
When some commands described in "Table 1.3.2 Table of format-changed command 
correspondence" are created with the GX Developer with the EZMotion-NC E60/E68 command sign 
left as is, an error results and creation cannot be carried out. Create the commands using the GX 
Developer command sign described in the correspondence table. 
 

Table 1.3.2 Table of format-changed command correspondence 
 EZMotion-NC E60/E68 command Format-changed command 

Classification Command 
sign Symbol Command 

sign Symbol Remarks

ROR ⎯[ ROR  n ]  ROR ⎯[ ROR  D  n ] 
RCR ⎯[ RCR  n ] RCR ⎯[ RCR  D  n ] 
DROR ⎯[ DROR  n ] DROR ⎯[DROR  D  n ] 

Right rotation 

DRCR ⎯[ DRCR  n ] DRCR ⎯[ DRCR  D  n] 
ROL ⎯[ ROL  n ] ROL ⎯[ ROL  D  n ] 
RCL ⎯[ RCL  n ] RCL ⎯[ RCL  D  n ] 
DROL ⎯[ DROL  n ] DROL ⎯[ DROL  D  n ] 

Left rotation 

DRCL ⎯[ DRCL  n ] DRCL ⎯[ DRCL  D  n ] 

∗1 

Search SER ⎯[ SER  S1  S2  n ] SER ⎯[ SER S1  S2 D n ] ∗2 
Quantity of 1 SUM ⎯[ SUM  S ] SUM ⎯[ SUM S D ] ∗3 

∗1 : D is the head No. of the rotation device 
∗2 : D is the head No. of the device that stores the search results 
∗3 : D is the head No. of the device that stores the total No. of bits 
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Appendix 1.3.3  Commands that can be Used with the GX Developer, but cannot be Used 
by the EZMotion-NC E60/E68 

 
When commands that cannot be used by the EZMotion-NC E60/E68 are written from the GX 
Developer to the EZMotion-NC E60/E68, they are rewritten to "NOP" commands, and if they are run, 
an alarm will occur. (Note that commands described in "Table 1.3.1 Table of alternate command 
correspondence" are rewritten to the corresponding EZMotion-NC E60/E68 commands.) 
"Commands that can be used by the GX Developer, but cannot be used in the EZMotion-NC 
E60/E68" are defined by the following expression. 
 
"Commands that can be used by the GX Developer, but cannot be used in the EZMotion-NC 

E60/E68" 
= "All commands described in the QnA Programming Instruction Manual" 

- ("All commands described in the PLC Programming Instruction Manual" 
+ "Table 1.3.1 Table of alternate command correspondence" 
+ "Table 1.3.2 Table of format-changed command correspondence") 

 
Refer to "Appendix 2. LIST OF COMMANDS THAT CAN BE USED WITH GX Developer". 
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APPENDIX 2.  LIST OF COMMANDS THAT CAN BE USED WITH 
 GX Developer 
 

The following command lists are excerpts from the "QnACPU Programming Manual (Common 
Commands)" (model name: QNACPU-P (KYOUTU) 13J522). 
In these lists, the commands "marked " are unavailable for the EZMotion-NC E60/E68. (When 
written from GX Developer to the EZMotion-NC E60/E68, they are replaced by "NOP" commands.) 

 
Appendix 2.1  Sequence Commands 

Contact commands 
Classifi-
cation 

Command 
sign Symbol 

LD  

LDI  

AND  

ANI  

OR  

ORI  

LDP  

LDF  

ANDP  

ANDF  

ORP  

Contact 

ORF  

Coupling commands 
Classifi-
cation

Command 
sign Symbol 

ANB ANB  

ORB ORB 

MPS 

MRD 

MPP 

MPS

MRD

MPP

INV  

MEP  

MEF  

EGP 
Vn

 

Coupling

EGF 
Vn

 

Output commands 
Classifi-
cation 

Command 
sign Symbol 

OUT 

SET SET D

RST RST D

PLS PLS D

PLF PLF D

FF FF D

DELTA DELTA D

Output 

DELTAP DELTAP D

Shift commands 
Classifi-
cation

Command 
sign Symbol 

SFT SFT DShift 

SFTP SFTP D

 
Master control commands 

Classifi-
cation

Command 
sign Symbol 

MC MC n D
Master 
control

MCR MCR n
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End commands 

Classifi-
cation 

Command 
sign Symbol 

FEND FENDProgram 
end 

END END

 

Other commands 
Classifi-
cation

Command 
sign Symbol 

Stop STOP STOP

NOP 

NOPLF NOPLF

No 
opera- 
tion 

PAGE PAGE n

 
 
Appendix 2.2  Comparison Operation Commands 
 

Comparison operation commands 
Classifi-
cation 

Command 
sign Symbol 

LD  S1 S2  

AND  S1 S2  

OR  S1 S2
 

LD  S1 S2  

AND  S1 S2  

OR  S1 S2  

LD  S1 S2  

AND  S1 S2  

OR  S1 S2
 

LD  S1 S2  

AND  S1 S2  

OR   
S1 S2  

LD  S1 S2  

AND  S1 S2  

OR  S1 S2  

LD  S1 S2  

AND  S1 S2  

16-bit 
data 
compar-
ison 

OR  S1 S2  

 

Comparison operation commands (Continued)
Classifi-
cation

Command 
sign Symbol 

LDD  D S1 S2  

ANDD  D S1 S2  

ORD  D S1 S2
 

LDD  D S1 S2  

ANDD D S1 S2  

ORD  D S1 S2
 

LDD  D S1 S2  

ANDD  D S1 S2  

ORD  S1 S2D

LDD  D S1 S2  

ANDD D S1 S2  

ORD  D S1 S2  

LDD  D S1 S2  

ANDD  D S1 S2  

ORD  D S1 S2  

LDD  D S1 S2  

ANDD D S1 S2  

32-bit 
data 
compar-
ison 

ORD  D S1 S2  
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Comparison operation commands (Continued)
Classifi-
cation 

Command 
sign Symbol 

LDE  E S1 S2  

ANDE  E S1 S2  

ORE  E S1 S2
 

LDE  E S1 S2  

ANDE  E S1 S2  

ORE  E S1 S2  

LDE  E S1 S2  

ANDE  E S1 S2  

ORE  E S1 S2
 

LDE  E S1 S2  

ANDE  E S1 S2  

ORE  E S1 S2  

LDE  E S1 S2  

ANDE  E S1 S2  

ORE  E S1 S2  

LDE  E S1 S2  

ANDE  E S1 S2  

Real 
number 
data 
compar-
ison 

ORE  E S1 S2  

 

Comparison operation commands (Continued)
Classifi-
cation Command sign Symbol 

LD$  $ S1 S2  

AND$  $ S1 S2  

OR$  $ S1 S2

LD$  $ S1 S2  

AND$  $ S1 S2  

OR$  $ S1 S2

LD$  $ S1 S2  

AND$  $ S1 S2  

OR$  $ S1 S2

LD$  $ S1 S2  

AND$  $ S1 S2  

OR$  $ S1 S2

LD$  $ S1 S2  

AND$  $ S1 S2  

OR$  $ S1 S2

LD$  $ S1 S2  

AND$  S1 S2$  

Charac-
ter 
string 
data 
compar-
ison 

OR$  $ S1 S2

BKCMP  BKCMP nS1 S2 D

BKCMP  BKCMP nS1 S2 D

BKCMP  BKCMP nS1 S2 D

BKCMP  BKCMP nS1 S2 D

BKCMP  BKCMP nS1 S2 D

BKCMP  BKCMP nS1 S2 D

BKCMP P BKCMP nS1 S2 DP

BKCMP P BKCMP nS1 S2 DP

BKCMP P BKCMP nS1 S2 DP

BKCMP P BKCMP nS1 S2 DP

BKCMP P BKCMP nS1 S2 DP

Block 
data 
compar-
ison 

BKCMP P BKCMP nS1 S2 DP
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Arithmetic operation commands 

Classifi- 
cation 

Command 
sign Symbol 

+ + S D

+P +P S D

+ + S1 S2 D

+P +P S1 S2 D

 S D

P P S D

 S1 S2 D

BIN 
16-bit 
addition/
subtrac- 
tion 

P P S1 S2 D

D+ D+ S D

D+P D+P S D

D+ D+ S1 S2 D

D+P D+P S1 S2 D

D  D DS

D P D S DP

D  D S1 S2 D

BIN 
32-bit 
addition/
subtrac- 
tion 

D P D S1 S2 DP

* S1 S2 D

*P S1 S2 DP

/ / S1 S2 D

BIN 
16-bit 
multipli- 
cation/ 
division  

/P /P S1 S2 D

D* D S1 S2 D

D*P D S1 S2 DP

D/ D/ S1 S2 D

BIN 
32-bit 
multipli- 
cation/ 
division 

D/P D/P S1 S2 D

 

* 

*

*

*

Arithmetic operation commands (Continued)
Classific

ation
Command 

sign Symbol 

B+ B+ DS

B+P B+P S D

B+ B+ S1 S2 D

B+P B+P S1 S2 D

B  B DS

B P B DSP

B  B S1 S2 D

BCD 
4-digit 
addition
/subtrac
tion 

B P B S1 S2 DP

DB+ DB+ S D

DB+P DB+P S D

DB+ DB+ S1 S2 D

DB+P DB+P S1 S2 D

DB  DB S D

DB P DB S DP

DB  DB S1 S2 D

BCD 
8-digit 
addition
/subtrac
tion 

DB P DB S1 S2 DP

B* B S1 S2 D

B*P B S1 S2 DP

B/ B/ S1 S2 D

BCD 
4-digit 
multipli
cation/
division

B/P B/P S1 S2 D

DB* DB S1 S2 D

DB*P DB S1 S2 DP

DB/ DB/ S1 S2 D

BCD 
8-digit 
multipli
cation/
division

DB/P DB/P S1 S2 D

 

*

*

* 

*
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Arithmetic operation commands (Continued)
Classifi- 
cation 

Command 
sign Symbol 

E+ E+ S D

E+P E+P S D

E+ E+ S1 S2 D

E+P E+P S1 S2 D

E  E S D

E P E S DP

E  E S1 S2 D

Floating-
point 
data 
addition/ 
subtrac- 
tion 

E P E S1 S2 DP

E  E S1 S2 D

E P E S1 S2 DP

E/ E/ S1 S2 D

Floating-
point 
data 
multiplic-
ation/ 
division E/P E/P S1 S2 D

BK+ BK+ S1 S2 nD

BK+P BK+P S1 S2 nD

BK  BK S1 S2 nD

BIN block 
addition/ 
subtrac- 
tion 
 

BK P BK S1 S2 nDP

$+ $+ S D

$+P $+P S D

$+ $+ S1 S2 D

Charac- 
ter 
string 
data 
coupling 

$+P $+P S1 S2 D

INC INC D

INCP INCP D

DINC DINC D

DINCP DINCP D

DEC DDEC 

DECP DECP D

DDEC DDEC D

BIN data 
incre- 
ment 

DDECP DDECP D

Data conversion commands 
Classifi- 
cation 

Command 
sign Symbol 

BCD BCD S D

BCDP BCDP S D

DBCD DBCD S D

BCD 
conver- 
sion 

DBCDP DBCDP S D

Data conversion commands (Continued) 
Classifi-
cation

Command 
sign Symbol 

BIN BIN S D

BINP BINP S D

DBIN DBIN S D

BIN 
conver- 
sion 

DBINP DBINP S D

FLT FLT S D

FLTP FLTP S D

DFLT DFLT S D

BIN -> 
floating-
point 
conver- 
sion 

DFLTP DFLTP S D

INT INT S D

INTP INTP S D

DINT DINT S D

Floating-
point -> 
BIN 
conver- 
sion 

DINTP DINTP S D

DBL DBL S D

DBLP DBLP S D

WORD WORD S D

BIN 
16-bit <->
32-bit 
conver- 
sion 

WORDP WORDP S D

GRY GRY S D

GRYP GRYP S D

DGRY DGRY S D

BIN -> 
gray code
conver- 
sion 

DGRYP DGRYP S D

GBIN GBIN S D

GBINP GBINP S D

DGBIN DGBIN S D

Gray 
code -> 
BIN 
conver- 
sion 

DGBINP DGBINP S D

NEG DNEG 

NEGP NEGP D

DNEG DNEG D

DNEGP DNEGP D

ENEG ENEG D

2's 
comple-
ment 
 

ENEGP ENEGP D

BKBCD BKBCD nS D

BKBCDP BKBCDP nS D

BKBIN BKBIN nS D

Block 
conver- 
sion 

BKBINP BKBINP nS D
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Data transfer commands 

Classifi- 
cation 

Command 
sign Symbol 

MOV DMOV S16-bit 
data 
transfer MOVP MOVP S D

DMOV DMOV S D32-bit 
data 
transfer DMOVP DMOVP S D

EMOV EMOV S DFloating-
point 
data 
transfer EMOVP EMOVP S D

$MOV $MOV S DCharac- 
ter string 
data 
transfer $MOVP $MOVP S D

CML CML S D16-bit 
data NOT 
transfer CMLP CMLP S D

DCML DCML S D32-bit 
data NOT 
transfer DCMLP DCMLP S D

BMOV BMOV nS DBlock 
transfer 

BMOVP BMOVP nS D

FMOV FMOV nS DSame 
data 
block 
transfer FMOVP FMOVP nS D

XCH XCH S D16-bit 
data 
change XCHP XCHP S D

DXCH DXCH S D32-bit 
data 
change DXCHP DXCHP S D

BXCH BXCH nS DBlock 
data 
change BXCHP BXCHP nS D

SWAP SWAP DUpper/ 
lower 
byte 
change SWAPP SWAPP D

 

Program branch commands 
Classifi-
cation

Command 
sign Symbol 

CJ CJ Pn

SCJ SCJ Pn

JMP JMP Pn

Jump 

GOEND GOEND

 
Program execution control commands 

Classifi-
cation

Command 
sign Symbol 

Interrupt 
disable DI DI

Interrupt 
enable EI EI

Interrupt 
disable/ 
enable 
setting 

IMASK IMASK S

Return IRET IRET

 
I/O refresh commands 

Classifi-
cation

Command 
sign Symbol 

I/O 
refresh RFS RFS nD

 
Other useful commands 

Classifi-
cation

Command 
sign Symbol 

UDCNT1 UDCNT1 nS DUp/down 
counter 

UDCNT2 UDCNT2 nS D

Teaching 
timer TTMR TTMR nD

Special 
timer STMR STMR nS D

Nearest 
access 
control 

ROTC ROTC n2n1S D

Ramp 
signal RAMP RAMP D1 n3n1 n2 D2

Pulse 
density SPD SPD nS D

Pulse 
output PLSY PLSY n1 n2 D

Pulse 
width 
modula-
tion 

PWM PWM n1 n2 D

Matrix 
input MTR MTR D2 nD1S
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Appendix 2.3  Application Commands 
 

Logical operation commands 
Classifi- 
cation 

Command 
sign Symbol 

WAND WAND S D

WANDP WANDP S D

WAND WAND S1 S2 D

WANDP WANDP S1 S2 D

DAND DAND S D

DANDP DANDP S D

DAND DAND S1 S2 D

DANDP DANDP S1 S2 D

BKAND BKAND nS1 S2 D

AND 

BKANDP BKANDP nS1 S2 D

WOR WOR S D

WORP WORP S D

WOR WOR S1 S2 D

WORP WORP S1 S2 D

DOR DOR DS

DORP DORP DS

DOR DOR S1 S2 D

DORP DORP S1 S2 D

BKOR BKOR nS1 S2 D

OR 

BKORP BKORP nS1 S2 D

WXOR WXOR S D

WXORP WXORP S D

WXOR WXOR S1 S2 D

WXORP WXORP S1 S2 D

DXOR DXOR S D

DXORP DXORP S D

DXOR DXOR S1 S2 D

DXORP DXORP S1 S2 D

BKXOR BKXOR nS1 S2 D

Exclusive 
OR 

BKXORP BKXORP nS1 S2 D

Logical operation commands (Continued) 
Classifi-
cation

Command 
sign Symbol 

WXNR WXNR DS

WXNRP WXNRP DS

WXNR WXNR S1 S2 D

WXNRP WXNRP S1 S2 D

DXNR DXNR DS

DXNRP DXNRP DS

DXNR DXNR S1 S2 D

DXNRP DXNRP S1 S2 D

BKXNOR nBKXNOR S1 S2 D

NOT- 
exclusive 
OR 

BKXNORP nBKXNORP S1 S2 D

 
Rotation commands 

Classifi-
cation

Command 
sign Symbol 

ROR nROR D

RORP RORP nD

RCR RCR nD

Right 
rotation 

RCRP RCRP nD

ROL ROL nD

ROLP ROLP nD

RCL RCL nD

Left 
rotation 

RCLP RCLP nD

DROR DROR nD

DRORP DRORP nD

DRCR DRCR nD

Right 
rotation 

DRCRP DRCRP nD

DROL DROL nD

DROLP DROLP nD

DRCL DRCL nD

Left 
rotation 

DRCLP DRCLP nD
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Shift commands 

Classifi- 
cation 

Command 
sign Symbol 

SFR SFR nD

SFRP SFRP nD

SFL SFL nD

n-bit shift 

SFLP SFLP nD

BSFR BSFR nD

BSFRP BSFRP nD

BSFL BSFL nD

1-bit shift 

BSFLP BSFLP nD

DSFR DSFR nD

DSFRP DSFRP nD

DSFL DSFL nD

1-word 
shift 

DSFLP DSFLP nD

 
Bit processing commands 

Classifi- 
cation 

Command 
sign Symbol 

BSET BSET nD

BSETP BSETP nD

BRST BRST nD

Bit 
set/reset 

BRSTP BRSTP nD

TEST TEST S1 S2 D

TESTP TESTP S1 S2 D

DTEST DTEST S1 S2 D

Bit test 

DTESTP DTESTP S1 S2 D

BKRST 
 

BKRST nS
Bit device 
Batch 
reset 

BKRSTP BKRSTP nS

 

Data processing commands 
Classifi-
cation

Command 
sign Symbol 

SER SER nS1 S2 D

SERP SERP nS1 S2 D

DSER DSER nS1 S2 D

Data 
search 

DSERP DSERP nS1 S2 D

SUM SUM S D

SUMP SUMP S D

DSUM DSUM S D

Bit check

DSUMP DSUMP S D

DECO DECO nDSDecode 

DECOP DECOP nDS

ENCO ENCO nDSEncode 

ENCOP ENCOP nDS

SEG SEG S D7- 
segment 
decode SEGP SEGP S D

DIS DIS nS D

DISP DISP nS D

UNI UNI nS D

UNIP UNIP nS D

NDIS NDIS S1 S2D

NDISP NDISP S1 S2D

NUNI NUNI S1 S2D

NUNIP NUNIP S1 S2D

WTOB WTOB nS D

WTOBP WTOBP nS D

BTOW DBTOW S n

Dissocia-
tion 
• 
Associa-
tion 

BTOWP BTOWP nS D
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Data processing commands (Continued) 

Classifi- 
cation 

Command 
sign Symbol 

MAX MAX nS D

MAXP MAXP nS D

MIN MIN nS D

MINP MINP nS D

DMAX DMAX nS D

DMAXP DMAXP nS D

DMIN DMIN nS D

Retrieval 

DMINP DMINP nS D

SORT 

n SORT S1 S2 D1 D2
S2:Number of data blocks to 

be compared at a time.
D1:Device to be forced ON 

at sort completion 
D2:Used by system 

Sort 

DSORT 

n DSORT S1 S2 D1 D2
S2:Number of data blocks to 

be compared at a time.
D1:Device to be forced ON 

at sort completion 
D2:Used by system 

WSUM WSUM nS D

WSUMP WSUMP nS D

DWSUM DWSUM nS D

Total 
value 
calcula- 
tion 

DWSUMP DWSUMP nS D

 
Table operation commands 

Classifi- 
cation 

Command 
sign Symbol 

FIFW FIFW S D

FIFWP FIFWP S D

FIFR FIFR S D

FIFRP FIFRP S D

FPOP FPOP S D

FPOPP FPOPP S D

FINS FINS nS D

FINSP FINS nS D

FDEL FDEL nS D

Table 
process- 
ing 

FDELP FDELP nS D

Structuring commands 
Classifi-
cation

Command 
sign Symbol 

FOR FOR n

NEXT NEXT

BREAK BREAK PnD

Repeat 

BREAKP BREAKP PnD

CALL CALL Pn S1~Sn

CALLP CALLP Pn S1~Sn

RET RET

FCALL FCALL Pn S1~Sn

FCALLP FCALLP Pn S1~Sn

ECALL 
SORT *

* : Program name 
Pn S1~Sn

ECALLP 
ECALLP *

* : Program name 
Pn S1~Sn

EFCALL 
EFCALL *

* : Program name 
Pn S1~Sn

EFCALLP
EFCALLP *
* : Program name 

Pn S1~Sn

Sub- 
routine 
program 
call 

COM COM

IX 

IX S

Device qualification circuit

IXEND

IXEND 

IXDEV IXDEV

Fixed 
index 
qualifica-
tion 

IXSET 

IXSET D

Designation of qualification 
value 

Pn
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APPENDIX 3.  TITLE SCREEN CUSTOMIZATION 
 
Appendix 3.1  Outline 

 
This function is for customizing the title screen which appears when the power is turned ON. By 
customizing, a machine tool builder name, machine tool model name, etc can be displayed. 
By inputting an image file created by PC into the NC with the RS-232C input/output function, the 
image data can be displayed as the title screen. 

 
 

MITSUBISHI CNC 
 

EZMotion-NC  E60 
 
 
CNC: EZMotion-NC E60 
COPYRIGHT(C) 2007 
MITSUBISHI ELECTRIC CORPORATION 
ALL RIGHTS RESERVED 

Original screen 

CNC:EZMotion-NC E60 
COPYRIGHT(C) 2007 
MITSUBISHI ELECTRIC CORPORATION 
ALL RIGHTS RESERVED 

Example of customized title screen 

MITSUBISHI CNC EZMotion-NC E60 
MITSUBISHI CNC EZMotion-NC E60 
MITSUBISHI CNC EZMotion-NC E60 
MITSUBISHI CNC EZMotion-NC E60 

 
Appendix 3.2  Details 

 
Appendix 3.2.1  Display Specification 

 
The area for customization is as below. 

 
 

CNC:EZMotion-NC E60 
COPYRIGHT(C) 2007 
MITSUBISHI ELECTRIC CORPORATION 
ALL RIGHTS RESERVED 

640 pixels 

250 pixels 

450 pixels 

Display area for title 
screen customization

Origin of display

 
No. Item Specification Note 

1 Display 
area 640 pixels r 250 pixels 

Full size of screen is 640 pixels r 450 pixels. 
(The bottom part of screen (640 pixels r 200 
pixels) is not open for customization.) 

2 Color Monochrome  

3 Origin of 
display Left top of screen  
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Appendix 3.2.2  Input Data Specification 
 
Input the data to display in the title screen customization area into the NC as bitmap data. 
The specifications of bitmap data to input are as follows. Data that doesn’t satisfy the specifications 
below cannot be input. 
 
No. Item Specification Note 

1 File type Bitmap File format 
for Windows 

Data whose format is other than Bitmap File for 
Windows cannot be input.  (For example, OS/2 
File) 

2 The number of 
bits per pixel Monochrome (1 bit) Data other than monochrome bitmap cannot be 

input. 

3 Data compression 
method 

Non-compression 
only (BI_RGB) 

Data other than non-compression (BI_RGB) 
cannot be input. 

4 Width Within 640 pixels Data for an image whose length is longer than 640 
pixels cannot be input. 

5 Height Within 250 pixels Data for an image whose length is longer than 250 
pixels cannot be input. 

 
[Note1]  Bitmap data that doesn’t apply the specified format causes an error. For the error 

messages, refer to "Appendix 3.5 Error". For the data input method, refer to "Appendix 
3.2.4 Data Input/Output Method". 

 
Appendix 3.2.3  Data Creation Method 

 
Create image data whose format is Windows Bitmap with a general drawing software. 
In this manual, a method by using Microsoft Windows’ Microsoft(R) Paint is explained. 
 
 

1) From among "Image", select 
"Attributes...". 

2) In the Attributes dialogue box, set as 
follows, Width=640, Height=250, 
Units=Pixels, Color=Black and White, 
and click "OK". 

Start Microsoft(R) Paint. 

Define a canvas. 



APPENDIX 3. TITLE SCREEN CUSTOMIZATION 
Appendix 3.2 Details 

 

 - 71 -

 
 

1) From among "File", select "Save As...".
2) Input the name of the file and save. 

Create the image. 

Save the data. 

 
[Note]  Set the background color of the bitmap data as black. 
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Appendix 3.2.4  Data Input/Output Method 
 
Bitmap data for the title screen customization area can be input/output or compared by the RS-
232C input/output function. The RS-232C input/output function is to input/output NC data by 
connecting the serial port of NC and an RS-232C device. 
To input/output the bitmap data, set the PLC bit selection parameter (#6451/bit5) to "0". 
In this input/output method, image data whose format is Bitmap File for Windows can be 
input/output directly. 
The PC side setting for communication between NC and PC is as in the table below. The RS-232C 
setting on the NC side is automatically done. 

 
<Setting on PC side> 

No. Item Setting 
1 Communication protocol XMODEM-CRC 
2 Baud rate 38400bps 
3 Data bit 8bits 
4 Parity No setting 
5 Stop bit 1 
6 Flow control No setting 

 
Procedure on the NC side (Eg. Inputting) and on the PC side are as follows. 
 
<Procedure on NC side> 

 
Connect an RS-232C input/output 

device. 

Input "70" in the # bracket. 

 

#(70) DATA(        ) 

Push 
  

DIAGN 
IN/OUT , then 

 

 

INPUT  to display the 

data input screen. 

#(  70) DATA(        ) 

 [DATA INPUT] IN/OUT 1 
 <LOCK> #10 MODE 
 # 1 MAIN PROGRAM      1:IN  2:COMP 
 # 2 TOOL DATA OFF #11 PORT No.2
 # 3 PARAMETER OFF #12 DEVICE No.1
 # 5 COMMON VARI OFF  (FDD:9600bps) 
 #30 MACRO PROGRAM #28 AUX-PARA 
 #60 TRACE DATA 
 <INPUT DATA>  #99 MAINTENANCE 
 
  
 
 <COMP. DATA> 
 
 #(   )  DATA(          ) (        )  

INPUT OUTPUT ERASE FILE MENU 
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Push 

 

 

INPUT . 

1) After pushing the 
 

 

INPUT  key, the data 
input/output screen will appear. 

2) After reading the data successfully, the 
input data will be written on the ROM. 
In this case, the "DATA WRITING" 
message appears on screen. 

#(  70) DATA(        ) 

<INPUT DATA> 
<COMP. DATA> 

DATA IN EXECUTION 

#(    ) DATA(        ) 

<INPUT DATA> 
<COMP. DATA> 

DATA WRITING 

#(    ) DATA(        ) 

<INPUT DATA> 
<COMP. DATA> 

DATA INPUT FINISH 

 
 

[Note1]  In the case of comparison, after the data input screen appears, input "10" in the # 
bracket and "2" in the DATA bracket. 

 
[Note2]  In the case of output, push 

 

DIAGN 
IN/OUT  then 

 

 

OUTPUT  to display the data output screen, and 
perform the same procedure as in input. 
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<Procedure on PC side> 
In this manual, a method to use Hyper Terminal that accompanies with Microsoft Windows is 
explained. 

 

∗ The setting and selection above are not 
necessary if they have already been set

Connect an RS-232C input/output 

device. 

Set the connection name and icon. 

Start-up Hyper Terminal. 

Select a phone number and serial 

port (COM) to connect. 

Set the setting of the serial port 

(COM). 
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∗ Select "Send" or "Receive" from among 
the transfer menu. Input the file name, 
and select XMODEM for protocol. 

Sending/Receiving the data starts. 

Send the bitmap data from the PC. 

∗ During sending/receiving, the number of 
packets is renewed. 

 
[Note1]  Trying data output without inputting bitmap data beforehand causes an error. For 

details of the error message, refer to "Appendix 3.5 Error". 
 
[Note2]  Trying to input bitmap data that doesn’t apply "Appendix 3.2.2 Input Data 

Specification" causes an error. For the error message, refer to "Appendix 3.5 Error". 
 
[Note3]  When the NC is in "DATA IN EXECUTION" or "DATA OUTPUTTING", if no 

communication exists for more than ten seconds, the timeout error will occur. 
 
[Note4]  By inputting the NC reset, data communication can be interrupted. 

However, it is ignored while data is being written. 
 
[Note5]  Turning the power OFF while data is being written may destroy the data. 

Do not turn the power OFF while data is being written. 
 
[Note6]  When "70" is set in the # bracket, a value in the DATA bracket is ignored. 
 
[Note7]  Availability of bitmap data output depends on the software’s version. 
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Appendix 3.2.5  Maintenance Data Input/Output Method 
 
In the data input/output screen, batch input/output or comparison of each kind of data is possible. 
Title screen customization data is included in this operation. For details of the batch data operation, 
refer to III SETUP 8. Maintenance Functions of "EZMotion-NC E60/E68 Series Operation Manual" 
(IB-1500172(ENG)). 
 

No. Data content ALL output 
250 Ladder program 
269 Title screen customization data 

ALL3 

 
<Input procedure> 

 

Push 
 

 

INPUT . 

#(  99) DATA(     269) 

<INPUT DATA> 
<COMP. DATA> 

DATA IN EXECUTION 

#(    ) DATA(        ) 

<INPUT DATA> 
<COMP. DATA> 

DATA WRITING 

#(    ) DATA(        ) 

<INPUT DATA> 
<COMP. DATA> 

DATA INPUT FINISH 

Stop the user PLC. 

Push 
  

DIAGN 
IN/OUT , then 

 

 

INPUT  to bring the 

data input/output screen. 

Input "99" in the # bracket. 

#(99) DATA(        ) 

∗ In the case of comparison, after the data 
input screen appears, input "10" in the # 
bracket and "2" in the DATA bracket. 
#(10) DATA(      2) 

#(  99) DATA(        ) 

 
 



APPENDIX 3. TITLE SCREEN CUSTOMIZATION 
Appendix 3.2 Details 

 

 - 77 -

<Output procedure> 

 

Push 
 

 

INPUT . 

#(  99) DATA(    ALL3) 

<INPUT DATA> 
<COMP. DATA> 

DATA OUTPUTTING 

#(    ) DATA(        ) 

<INPUT DATA> 
<COMP. DATA> 

DATA OUTPUT FINISH 

Stop the user PLC. 

Push 
  

DIAGN 
IN/OUT , then 

 

 

OUTPUT  to bring the 

data input/output screen. 

Input "99" in the # bracket. 

#(99) DATA(    ALL3) 
#(  99) DATA(    ALL3) 

 
 

[Note1]  In the output above, data isn’t output in the bitmap format, So the output data cannot 
be edited with a general drawing software such as Microsoft Paint(R). 

 
[Note2]  If no bitmap data is registered, output won’t be performed. 
 
[Note3]  By inputting the NC reset, data communication can be interrupted. 

However, it is ignored while data is being written. 
 
[Note4]  Turning the power OFF while data is being written may destroy the data. 

Do not turn the power OFF while data is being written. 
 
[Note5]  The setting of the data protection key is ignored. 
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Appendix 3.2.6  Screen Display 
 
By validating the base specification parameter #1217/bit4, the customized title screen will appear. 
The title screen appears only immediately after turning the power ON. 
 
 1           2           3           4

0 
1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 
16 
17 

CNC:EZMotion-NC E60 
COPYRIGHT(C) 2007 
MITSUBISHI ELECTRIC CORPORATION 
ALL RIGHTS RESERVED 

Customized title part 

1234567890123456789012345678901234567890

 
 

[Note1]  If no bitmap data is registered, nothing will be displayed in the title screen 
customization area. 

 
 

Appendix 3.3  Connection 
 
Use serial cables (cloth cable) for the connection between the NC and PC. Wiring in the case of 25 
pins / 3 connections is as follows. 
 
 

NC 
2  SD 
3  SD 
4  RTS 
5  CTS 
20 DTR 
6  DSR 
8  CD 
7  SG 
1  FG 

PC 
2  SD 
3  RD 
4  RTS 
5  CTS 
20 DTR 
6  DSR 
8  CD 
7  SG 
1  FG 

 
 



APPENDIX 3. TITLE SCREEN CUSTOMIZATION 
Appendix 3.4 Parameter 

 

 - 79 -

Appendix 3.4  Parameter 
 
(1) Base specification parameter 

# Item Detail Setting range
1217 aux01 Bit4 Title screen customization valid 0/1 

 
 
Appendix 3.5  Error 

 
(1) Operation error 

Error # Meaning Remedy 

E350 title error 1 No title screen 
customization data. 

Data output is performed without inputting 
title screen customization data beforehand. 

E351 title error 2 

Format of title screen 
customization data illegal. 

The title screen customization data which 
have been input is not Bitmap File for 
Windows. Perform the input after converting 
the data into Bitmap File for Windows. 

E352 title error 3 

Color type of title screen 
customization data illegal. 

The setting of the title screen customization 
data which have been input is not 
monochrome bitmap for Bitmap File for 
Windows. Perform the input after converting 
the data into the monochrome setting of 
Bitmap File for Windows. 

E353 title error 4 

Compression method of title 
screen customization data 
illegal. 

The compression setting of the title screen 
customization data which have been input is 
not non-compression that applies to the 
Bitmap File for Windows. 
Perform the input after saving the data with 
another drawing software. 

E354 title error 5 

Display size of title screen 
customization data illegal. 

The size of the customized title part is 
exceeding 640 pixels r 250 pixels. Perform 
the input after changing the size to be 640 
pixels r 250 pixels. 

E355 title error 6 
Communication error. A communication error occurred during 

input/output of the bitmap data. Check the 
communication cables and parameters. 
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Global service network 

 

 

NORTH AMERICA FA Center 
EUROPEAN FA Center 

ASEAN FA Center 

CHINA FA Center 

TAIWAN FA Center 

HONG KONG FA Center 

KOREAN FA Center 

  
North America FA Center (MITSUBISHI ELECTRIC AUTOMATION INC.) 

Illinois CNC Service Center 
500 CORPORATE WOODS PARKWAY, VERNON HILLS, IL. 60061, U.S.A. 
TEL: +1-847-478-2500 (Se FAX:  +1-847-478-2650 (Se 
California CNC Service Center 
5665 PLAZA DRIVE, CYPRESS, CA. 90630, U.S.A. 
TEL: +1-714-220-4796 FAX:  +1-714-229-3818 
Georgia CNC Service Center 
2810 PREMIERE PARKWAY SUITE 400, DULUTH, GA., 30097, U.S.A. 
TEL: +1-678-258-4500 FAX: +1-678-258-4519      
New Jersey CNC Service Center 
200 COTTONTAIL LANE SOMERSET, NJ. 08873, U.S.A. 
TEL: +1-732-560-4500 FAX:  +1-732-560-4531 
Michigan CNC Service Satellite 
2545 38TH STREET, ALLEGAN, MI., 49010, U.S.A. 
TEL: +1-847-478-2500 FAX: +1-269-673-4092 
Ohio CNC Service Satellite 
62 W. 500 S., ANDERSON, IN., 46013, U.S.A. 
TEL: +1-847-478-2608 FAX:  +1-847-478-2690 
Texas CNC Service Satellite 
1000, NOLEN DRIVE SUITE 200, GRAPEVINE, TX. 76051, U.S.A. 
TEL: +1-817-251-7468 FAX:  +1-817-416-1439 
Canada CNC Service Center 
4299 14TH AVENUE MARKHAM, ON. L3R OJ2, CANADA 
TEL: +1-905-475-7728 FAX:  +1-905-475-7935 
Mexico CNC Service Center 
MARIANO ESCOBEDO 69 TLALNEPANTLA, 54030 EDO. DE MEXICO 
TEL: +52-55-9171-7662 FAX:  +52-55-9171-7698 
Monterrey CNC Service Satellite 
ARGENTINA 3900, FRACC. LAS TORRES, MONTERREY, N.L., 64720, MEXICO 
TEL: +52-81-8365-4171 FAX:  +52-81-8365-4171 
Brazil MITSUBISHI CNC Agent Service Center 
 (AUTOMOTION IND. COM. IMP. E EXP. LTDA.) 
ACESSO JOSE SARTORELLI, KM 2.1 18550-000 BOITUVA – SP, BRAZIL 
TEL: +55-15-3363-9900 FAX:  +55-15-3363-9911 

 
European FA Center (MITSUBISHI ELECTRIC EUROPE B.V.) 

Germany CNC Service Center 
GOTHAER STRASSE 8, 40880 RATINGEN, GERMANY 
TEL: +49-2102-486-0 FAX:+49-2102486-591 
South Germany CNC Service Center 
KURZE STRASSE. 40, 70794 FILDERSTADT-BONLANDEN, GERMANY 
TEL: +49-711-3270-010 FAX:  +49-711-3270-0141 
France CNC Service Center 
25, BOULEVARD DES BOUVETS, 92741 NANTERRE CEDEX FRANCE 
TEL: +33-1-41-02-83-13 FAX:  +33-1-49-01-07-25 
Lyon CNC Service Satellite 
 
U.K CNC Service Center 
TRAVELLERS LANE, HATFIELD, HERTFORDSHIRE, AL10 8XB, U.K. 
TEL: +44-1707-282-846 FAX:-44-1707-278-992 
Italy CNC Service Center 
VIALE COLLEONI 7  - PALAZZO SIRIO, CENTRO DIREZIONALE COLLEONI, 20041 AGRATE 
BRIANZA -  (MI), ITALY 
TEL: +39-039-60531-342 FAX: +39-039-6053-206 
Spain CNC Service Satellite 
CTRA. DE RUBI, 76-80 -APDO.420 08190 SAINT CUGAT DEL VALLES, BARCELONA SPAIN 
TEL: +34-935-65-2236 FAX: 
Turkey MITSUBISHI CNC Agent Service Center 
 (GENEL TEKNIK SISTEMLER LTD. STI.) 
DARULACEZE CAD. FAMAS IS MERKEZI A BLOCK NO.43 KAT2 80270 OKMEYDANI ISTANBUL, 
TURKEY 
TEL: +90-212-320-1640 FAX:  +90-212-320-1649  
Poland MITSUBISHI CNC Agent Service Center (MPL Technology Sp. z. o. o) 
UL SLICZNA 34, 31-444 KRAKOW, POLAND 
TEL: +48-12-632-28-85 FAX: 
Wroclaw MITSUBISHI CNC Agent Service Satellite (MPL Technology Sp. z. o. o) 
UL KOBIERZYCKA 23, 52-315 WROCLAW, POLAND 
TEL: +48-71-333-77-53 FAX: +48-71-333-77-53 
Czech MITSUBISHI CNC Agent Service Center 
 (AUTOCONT CONTROL SYSTEM S.R.O.  ) 
NEMOCNICNI 12, 702 00 OSTRAVA 2 CZECH REPUBLIC 
TEL: +420-596-152-426 FAX:  +420-596-152-112 

ASEAN FA Center (MITSUBISHI ELECTRIC ASIA PTE. LTD.) 
Singapore CNC Service Center 
307 ALEXANDRA ROAD #05-01/02 MITSUBISHI ELECTRIC BUILDING SINGAPORE   159943 
TEL: +65-6473-2308 FAX:  +65-6476-7439 
Thailand MITSUBISHI CNC Agent Service Center (F. A. TECH CO., LTD) 
898/19,20,21,22 S.V. CITY BUILDING OFFICE TOWER 1 FLOOR 12,14  RAMA III RD BANGPONGPANG, 
YANNAWA, BANGKOK 10120. THAILAND 
TEL: +66-2-682-6522 FAX:  +66-2-682-6020 
Malaysia MITSUBISHI CNC Agent Service Center 
 (FLEXIBLE AUTOMATION SYSTEM SDN. BHD.) 
60, JALAN USJ 10/1B 47620 UEP SUBANG JAYA SELANGOR DARUL EHSAN MALAYSIA 
TEL: +60-3-5631-7605 FAX: +60-3-5631-7636 
JOHOR MITSUBISHI CNC Agent Service Satellite 
 (FLEXIBLE AUTOMATION SYSTEM SDN. BHD.) 
NO. 16, JALAN SHAHBANDAR 1, TAMAN UNGKU TUN AMINAH, 81300 SKUDAI, JOHOR MALAYSIA 
TEL: +60-7-557-8218 FAX:  +60-7-557-3404 
Indonesia MITSUBISHI CNC Agent Service Center 
 (PT. AUTOTEKNINDO SUMBER MAKMUR) 
WISMA NUSANTARA 14TH FLOOR JL. M.H. THAMRIN 59, JAKARTA 10350 INDONESIA 
TEL:  +62-21-3917-144 FAX:  +62-21-3917-164 
India MITSUBISHI CNC Agent Service Center (MESSUNG SALES & SERVICES PVT. LTD.) 
B-36FF, PAVANA INDUSTRIAL PREMISES M.I.D.C., BHOASRI PUNE 411026, INDIA 
TEL: +91-20-2711-9484 FAX:  +91-20-2712-8115 
BANGALORE MITSUBISHI CNC Agent Service Satellite 
 (MESSUNG SALES & SERVICES PVT. LTD.) 
S 615, 6TH FLOOR, MANIPAL CENTER, BANGALORE 560001, INDIA 
TEL: +91-80-509-2119 FAX:  +91-80-532-0480 
Delhi MITSUBISHI CNC Agent Parts Center (MESSUNG SALES & SERVICES PVT. LTD.) 
1197, SECTOR 15 PART-2, OFF DELHI-JAIPUR HIGHWAY BEHIND 32ND MILESTONE    GURGAON 122001, 
INDIA 
TEL: +91-98-1024-8895 FAX: 
Philippines MITSUBISHI CNC Agent Service Center 
 (FLEXIBLE AUTOMATION SYSTEM CORPORATION) 
UNIT No.411, ALABAMG CORPORATE CENTER KM 25. WEST SERVICE ROAD SOUTH SUPERHIGHWAY, 
ALABAMG MUNTINLUPA METRO MANILA, PHILIPPINES 1771 
TEL: +63-2-807-2416 FAX: +63-2-807-2417 
Vietnam MITSUBISHI CNC Agent Service Center (SA GIANG TECHNO CO., LTD) 
47-49 HOANG SA ST. DAKAO WARD, DIST.1 HO CHI MINH CITY, VIETNAM 
TEL: +84-8-910-4763 FAX: +84-8-910-2593 

 
China FA Center (MITSUBISHI ELECTRIC AUTOMATION (SHANGHAI) LTD.) 

China CNC Service Center 
2/F., BLOCK 5 BLDG.AUTOMATION INSTRUMENTATION PLAZA, 103 CAOBAO RD.   SHANGHAI 200233, 
CHINA 
TEL:  +86-21-6120-0808 FAX: +86-21-6494-0178 
Shenyang CNC Service Center 
TEL: +86-24-2397-0184 FAX: +86-24-2397-0185 
Beijing CNC Service Satellite 
9/F, OFFICE TOWER1, HENDERSON CENTER, 18 JIANGUOMENNEI DAJIE,   DONGCHENG DISTRICT, 
BEIJING 100005, CHINA  
TEL: +86-10-6518-8830 FAX: +86-10-6518-8030 
China MITSUBISHI CNC Agent Service Center 
 (BEIJING JIAYOU HIGHTECH TECHNOLOGY DEVELOPMENT CO.) 
RM 709, HIGH TECHNOLOGY BUILDING NO.229 NORTH SI HUAN ZHONG ROAD, HAIDIAN DISTRICT , 
BEIJING 100083, CHINA 
TEL: +86-10-8288-3030 FAX: +86-10-6518-8030 
Tianjin CNC Service Satellite 
RM909, TAIHONG TOWER, NO220 SHIZILIN STREET, HEBEI DISTRICT, TIANJIN, CHINA 300143 
TEL: -86-22-2653-9090 FAX: +86-22-2635-9050 
Shenzhen CNC Service Satellite 
RM02, UNIT A, 13/F, TIANAN NATIONAL TOWER, RENMING SOUTH ROAD, SHENZHEN, CHINA 518005 
TEL:  +86-755-2515-6691 FAX: +86-755-8218-4776 
Changchun Service Satellite 
TEL: +86-431-50214546 FAX: +86-431-5021690 
Hong Kong CNC Service Center 
UNIT A, 25/F RYODEN INDUSTRIAL CENTRE, 26-38 TA CHUEN PING STREET, KWAI CHUNG, NEW 
TERRITORIES, HONG KONG 
TEL: +852-2619-8588 FAX: +852-2784-1323 
 

Taiwan FA Center (MITSUBISHI ELECTRIC TAIWAN CO., LTD.) 
Taichung CNC Service Center 
NO.8-1, GONG YEH 16TH RD., TAICHUNG INDUSTIAL PARK TAICHUNG CITY, TAIWAN R.O.C. 
TEL: +886-4-2359-0688 FAX: +886-4-2359-0689 
Taipei CNC Service Satellite 
TEL: +886-4-2359-0688 FAX: +886-4-2359-0689 
Tainan CNC Service Satellite 
TEL: +886-4-2359-0688 FAX: +886-4-2359-0689 

 
Korean FA Center (MITSUBISHI ELECTRIC AUTOMATION KOREA CO., LTD.) 

Korea CNC Service Center 
1480-6, GAYANG-DONG, GANGSEO-GU SEOUL 157-200, KOREA 
TEL: +82-2-3660-9631 FAX:  +82-2-3664-8668  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notice 
 

Every effort has been made to keep up with software and hardware revisions in the 
contents described in this manual. However, please understand that in some 
unavoidable cases simultaneous revision is not possible.  
Please contact your Mitsubishi Electric dealer with any questions or comments 
regarding the use of this product. 

 

 

Duplication Prohibited 
This manual may not be reproduced in any form, in part or in whole, without written permission 

from Mitsubishi Electric Corporation. 

   © 2008 MITSUBISHI ELECTRIC CORPORATION 

    ALL RIGHTS RESERVED. 
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